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1Safety

This chapter includes:
• Safety Introduction on page 8
• Operational Safety Information on page 9
• Electrical Information on page 10
• Emergency Power Off on page 11
• Maintenance Information on page 12
• Product Safety Certification on page 13
• Environmental Health and Safety Contacts on page 14
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Safety Introduction

Notices and Safety

Please read the following instructions carefully before operating the machine and refer to them as 
needed to ensure the continued safe operation of your machine.

Your Xerox product and supplies have been designed and tested to meet strict safety requirements. 
These include safety agency evaluation and certification, and compliance with electromagnetic 
regulations and established environmental standards. 

The safety and environment testing and performance of this product have been verified using Xerox 
materials only.

Warning: Unauthorized alterations, which may include the addition of new functions or connection of 
external devices, may impact the product certification. Please contact your Xerox representative for 
more information.
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Operational Safety Information

Your Xerox equipment and supplies have been designed and tested to meet strict safety requirements. 
These include safety agency examination, approval, and compliance with established environmental 
standards.

To ensure the continued safe operation of your Xerox equipment, follow these safety guidelines at all 
times:

Do These
• Always follow all warnings and instructions that are marked on or supplied with the equipment.
• Before cleaning this product, unplug the product from the USB port. Always use materials 

specifically designated for this product, the use of other materials may result in poor performance 
and create a hazardous situation. Do not use aerosol cleaners, they may be explosive and 
flammable under certain conditions.

• Always exercise care when moving or relocating equipment. 
• Always locate the machine on a solid support surface that has adequate strength to support the 

weight of the machine.
• Always locate the machine in an area that has adequate ventilation and room for servicing.
• Always unplug this equipment from the electrical outlet before cleaning.

Note: Your Xerox machine is equipped with an energy saving device to conserve power when the 
machine is not in use. The machine may be left on continuously.

Do Not Do These
• Never use a ground adapter plug to connect the equipment to a power outlet that lacks a ground 

connection terminal.
• Never attempt any maintenance function that is not specifically described in this documentation.
• Never remove covers or guards that are fastened with screws. There are no operator serviceable 

areas within these covers.
• Never locate the machine near a radiator or any other heat source.
• Never override or “cheat” any of the electrical or mechanical interlock devices.
• Never place this equipment where people might step on or trip on the power cord.
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Electrical Information

Warning - Electrical Safety Information

1. The power receptacle for the machine must meet the requirements stated on the data plate on 
the rear of the machine. If you are not sure that your electrical supply meets the requirements, 
please consult your local power company or an electrician for advice.

2. The socket outlet shall be installed near the equipment and shall be easily accessible.
3. Use the power cable that is supplied with your machine. Do not use an extension cord or remove 

or modify the power cord plug.
4. Plug the power cable directly into a correctly grounded electrical outlet. If you are not sure 

whether or not an outlet is correctly grounded, consult an electrician.
5. Do not use an adapter to connect any Xerox equipment to an electrical outlet that lacks a ground 

connection terminal.
6. Do not place this equipment where people might step or trip on the power cable.
7. Do not place objects on the power cable.
8. Do not override or disable electrical or mechanical interlock devices.
9. Do not push objects into slots or openings on the machine. Electrical shock or fire may result.

Electrical Supply

• This product shall be operated from the type of electrical supply indicted on the 
product’s data plate label. If you are not sure that your electrical supply meets the 
requirements, please consult your local power company for advice.

• Warning: This equipment must be connected to a protective earth circuit. This 
equipment is supplied with a plug that has a protective earth pin. This plug will only fit into an 
earthed electrical outlet. This is a safety feature. If you are unable to insert the plug into the 
outlet, contact your electrician to replace the outlet.

• Always connect equipment to a correctly grounded power outlet. If in doubt, have the outlet 
checked by a qualified electrician.

Disconnect Device

The power cable is the disconnect device for this equipment. It is attached to the back of the machine 
as a plug-in device. To remove all electrical power from the equipment, disconnect the power cable 
from the electrical outlet.
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Emergency Power Off

If any of the following conditions occur, turn off the machine immediately and disconnect the power 
cable(s) from the electrical outlet(s). Contact an authorized Xerox Service Representative to correct 
the problem:
• The equipment emits unusual odors or makes unusual noises.
• The power cable is damaged or frayed.
• A wall panel circuit breaker, fuse, or other safety device has been tripped.
• Liquid is spilled into the machine.
• The machine is exposed to water.
• Any part of the machine is damaged.
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Maintenance Information

1. Any operator product maintenance procedures will be described in the user documentation 
supplied with the product. 

2. Do not carry out any maintenance on this product which is not described in the customer 
documentation.

3. Do not use aerosol cleaners. The use of cleaners that are not approved may cause poor 
performance of the equipment, and could cause a dangerous condition.

4. Use supplies and cleaning materials only as directed in this manual. 
5. Do not remove covers or guards that are fastened with screws. There are no parts behind these 

covers that you can maintain or service. 
6. Do not perform any maintenance procedures unless you have been trained to do them by an 

authorized local dealer or unless a procedure is specifically described in the user manuals.
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Product Safety Certification

This product is certified by the following Agency using the Safety standards listed:

Agency Standard

Underwriters Laboratories Inc. UL60950-1 (USA)
CSA 22.2 No. 60950-1 (Canada)

TUV IEC 60950-1
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Environmental Health and Safety Contacts

Contact Information

For more information on Environment, Health, and Safety in relation to this Xerox product and supplies, 
please contact the following customer help lines:

USA & Canada: 1-800-828-6571
Europe: +44 1707 353 434
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2Welcome

This chapter includes:
• What’s in the Box on page 16
• System Requirements on page 17
• Documentation on page 18
• The Xerox DocuMate 4790 Scanner on page 19

Your new Xerox scanner can quickly scan stacks of single-sided or double-sided pages and place their 
electronic images on your computer.
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What’s in the Box

Before proceeding, check the contents of the box. If items are missing or damaged, contact the dealer 
where you purchased the scanner.

Xerox DocuMate 4790 
Scanner

Double Feed 
Prevention Roller

Blower Brush

Quick Install Guide

Roller Cleaning Paper

Power Cord

Technical Support Card

USB Cable

Shading paper

Windows™
Installation Disc
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System Requirements

IBM-compatible Pentium 4 PC, or AMD equivalent with:
• A DVD-ROM drive
• An available Universal Serial Bus (USB) port

• Microsoft® Windows® operating system: Windows XP (Service Pack 1 and 2), 32-bit or 64-bit 
Windows Vista, or 32-bit or 64-bit Windows 7
The scanner is compatible with Service Pack 3 for Windows XP and Service Pack 1 for Windows 
Vista.

• Windows XP: Minimum of 512 megabytes (MB) of internal memory (RAM)
Windows Vista and 7: Minimum of 1 gigabyte (GB) of internal memory (RAM)

• 350 MB minimum of free hard disk space

A VGA or SVGA Monitor

The recommended settings for your monitor are:
• Color quality of 16-bit or 32-bit
• Resolution set to at least 800 x 600 pixels

Refer to your Windows documentation for instructions on setting the color quality and resolution for 
the monitor.
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Documentation

The following documentation is provided with your scanner:
• Quick Install Guide—Abbreviated installation instructions. 
• Scanner User’s Guide—On the Installation Disc; contains detailed installation, scanning, 

configuration, and maintenance information.
• Nuance OmniPage User’s Guide—On the Installation Disc; contains detailed feature and 

configuration information for the OmniPage software.
• Kofax Virtual ReScan User’s Guide—On the Installation Disc; contains detailed feature and 

configuration information for the VRS software.
• EMC Captiva QuickScan User’s Guide—On the Installation Disc; contains detailed feature and 

configuration information for the QuickScan software.
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The Xerox DocuMate 4790 Scanner

Input tray—Holds the documents in the Automatic Document Feeder for scanning. 

Paper guides—Guides adjust to support various document widths.

Paper guide switch—Move the switch to change the input tray paper guides from synchronized 
adjustment to individual adjustment. 

ADF cover release—Pull to open the Automatic Document Feeder.

Manual feed selector switch—Adjusts the rollers and input tray from continuous automatic 
document feeding to manual document feeding. 

Exit tray—Where the documents are exited out of the scanner. Flip up an exit stopper to keep 
documents in the exit tray. Exit extension pulls out to support various document lengths. 

Control panel—Scanner hardware controls.
• LCD screen—Shows the current scan settings.

3

Paper guides Paper guide 
switch

Input tray ADF cover 
release

Manual feed 
switch

41 52

Control panel Power switch

Exit tray
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Pre-Imprinter 
door

USB port Power jack
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• Function buttons—Selects the scan setting for the One Touch buttons. Press the up or down 
arrow to cycle through the settings.

• Duplex button—Press to scan double-sided documents.
• Simplex button—Press to scan single-sided documents.
• DFS (Double Feed Skip) button—Press to continue scanning when a double page feed has been 

detected without correcting the double feed. This option is available when scanning in TWAIN. 
When scanning using the Simplex or Duplex button on the scanner, this button is disabled while 
scanning. 

Power switch—Turns the scanner’s power on or off.

Pre-Imprinter Door—Open to access the pre-imprinter compartment.

Universal Serial Bus (USB) port—Connects the scanner to the computer.

Power jack—Connects the power cord to the scanner.
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3Scanner Setup

This chapter includes:
• Unpack the Scanner on page 22
• Install the Double Feed Prevention roller on page 24
• Connect the Scanner Power Cord on page 27
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Unpack the Scanner

Use care when unpacking, moving and assembling the scanner. Follow these instructions to prevent 
injury and damage to the scanner.
1. Remove the scanner from the shipping box, verify all parts listed on page 16 are in the box.

We recommend that you keep the original packing materials in case you need them later.

2. Always have at least two people carry the scanner, lifting the scanner up from underneath.

3. Use a desk or table that can support the weight of the scanner, do not place the scanner on a cloth 
covered surface.
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4. Place the scanner on a level surface near the computer.
Keep at least 15 inches of space on every side of the scanner for the input and exit tray 
extensions, performing maintenance, and to have sufficient air flow for ventilation.

5. Remove all shipping tape from the top and side of the scanner.
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Install the Double Feed Prevention roller

1. Pull on the scanner cover release and lift the lid to open the scanner.

2. Pull up on the double feed prevention roller cover and remove it from the scanner. Set the cover 
aside and make sure nothing is set on the cover as it will break.
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3. Align the plastic gear end on the right side of the roller with the gears in the roller compartment. 
Make sure the flat side of the roller tip is aligned properly with the slot in the scanner. 
Carefully insert the gear end into the scanner and angle the roller down into the left side of the 
compartment.

4. Press gently on the metal bar on the left side to lock the roller in place with the black tab in the 
compartment.

5. Place the roller compartment cover in the scanner and lower it into place.
6. Press gently on the compartment cover to lock in the scanner. Make sure this cover is fully closed 

as it may break and cause damage to the scanner if it is not properly in place.
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7. Close the scanner when you are finished.
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Connect the Scanner Power Cord

1. Select the appropriate power cord for your country.
2. Plug the power cord into the scanner and into a wall outlet.

Note: Do not turn on the scanner until after you install the software.
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4Installation

This chapter includes:
• Before You Begin on page 30
• Install the Software and Connect the Scanner on page 31
• Register Your Scanner on page 39
• Installing Additional Applications on page 40
• View the User Guides on page 42
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Before You Begin

Please make sure of the following before you begin installation:
• If you are prompted to reboot during installation, please select "No". Finish installing the rest of 

the software, then close all open windows and reboot your computer. 
• Once you have plugged in your scanner, you may be notified that Windows needs to install driver 

software for your scanner. If so, click on "Locate and install driver software (recommended)" and 
follow any resulting instructions.

• The information in this guide may cover software not provided with the scanner you purchased. 
Please disregard any information about the software not applicable to your scanner. Visit our web 
site at www.xeroxscanners.com for the latest software updates for your Xerox scanner.

• If your computer has AntiVirus or AntiSpyware software running, you may encounter alerts or 
messages during installation asking you to allow the installation to proceed. Although the 
messages will differ based on the software your computer is running, in each case you should 
allow the installation to proceed if that option is available. Alternatively, you can turn off the 
AntiVirus or AntiSpyware software before installing your scanner, but if you do, make sure to turn 
it back on again when installation is finished.

• If you already have a scanner connected to your computer, it is recommended that you remove 
that scanner’s driver program prior to installing your Xerox scanner. You can remove these 
programs from the Windows Control Panel. Please refer to the user manual provided with your 
other scanner hardware for instructions about removing the driver and software for that unit.

• If your computer is running Windows Vista or Windows 7, you may see the Windows User Account 
Control screen asking you to confirm system changes. Click the Continue button to allow the 
installation to proceed.

• The Windows User Account Control (UAC) must be turned off prior to installing the Kofax VRS or 
Kofax Scan Demo software. The Kofax VRS installer will display a message stating "User Account 
Control is enabled on this machine. The VRS installer will not install correctly with this setting 
enabled. Please disable this setting from the User Accounts dialog in the Control Panel." The Kofax 
Scan Demo installer will display a message stating "Cannot find IC runtime. Install IC." Turn off 
the Windows UAC to complete the installation of these two software applications. You can turn 
UAC back on after the installation has completed. 
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Install the Software and Connect the Scanner

The installation disc contains the necessary driver, and scanning software, to use your Xerox scanner.

To install the software:
1. Start Microsoft Windows and make sure that no other applications are running.
2. Insert the installation disc into your computer’s DVD-ROM drive.

The disc automatically starts.

3. The Select Language window opens. Click the drop-down menu arrow and select the language to 
use. Click OK.

4. The disc’s Main Menu window opens.

Note: If the disc does not start, check the following:

• Make sure the disc drive’s door is completely shut.
• Make sure the disc was inserted in the drive in the proper direction (label side up).
To launch the disc manually:
• Open the Windows options for your computer’s disc drives.
• Double-click the icon for your DVD-ROM drive. 
• The Installation menu for the disc should now open.
If the menu does not open:
• From the list of files on the disc, double-click the file named frontend.exe.
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5. On the Main Menu, select Install Products.

6. Leave the default selections and click Install Now.
You cannot deselect the TWAIN and Windows Driver as they are required for the scanner to work.

Note: The software provided with your scanner may differ slightly from the list shown in the window.
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Installing the Scanner Driver

The TWAIN and Windows Driver installation will start first.
1. Click Next on the Welcome window.

2. On the Xerox License Agreement window, read the license agreement. If you accept the terms, 
select I Agree then click Next.
If you choose not to accept the license agreement, the installation will terminate and the scanner 
driver will not be installed.

3. Click Next on the screen asking you to confirm the scanner installation.
Xerox DocuMate 4790
User’s Guide

33



4. Click Yes if you see a User Account Control screen from Windows. 

5. STOP when you see the “Complete the installation by connecting your hardware” window. Do 
NOT click OK yet. Leave the window open and proceed to the next section.

Note: If you do not see this on-screen diagram for connecting the scanner, stop and follow the 
instructions below.

Connect the USB Cable and Turn on the Power

1. Remove any tape from the USB cable.
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2. Plug the USB cable into the USB port on the scanner then into a USB port on the computer. 

If the plug does not attach easily, make sure that you are plugging it in correctly. Do not force the 
plug into either connection.

3. Turn on the scanner power.

The status light comes on and flashes indicating that the scanner is receiving power.
Your computer recognizes that a scanner has been plugged into the USB port and automatically 
loads the appropriate software to run the scanner. If your computer is running Windows version 
XP or later, you will see a message similar to the one below. 
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4. When you’re certain that the software has completely loaded, return to the “Complete the 
installation by connecting your hardware” window. 

5. Click OK to complete the installation process.
6. Click Close on the Installation Complete window to close and exit the driver installer.

User Utility Installation

The User Utility installation will automatically start after you close the TWAIN installation. The User 
Utility is a software diagnostic and maintenance software that you can use for monitoring your 
scanner hardware.
1. On the Xerox User Utility License Agreement window, read the license agreement. If you accept 

the terms, select Yes to accept the agreement and continue with the installation.
If you choose not to accept the license agreement, the installation will terminate and the User 
Utility will not be installed.
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2. The next screen lets you choose where the installation files are going to be on your computer. Click 
on Browse... to change the location where the files are installed.
We recommend that you keep the default options on this window and just click on Next to 
proceed with the installation.

3. The next screen lets you change the Program Files folder name and where the program appears in 
your Windows Start Programs list.
The default options on this window will put the shortcut icon in your Windows All Programs list in 
the Xerox folder. We recommend that you keep the default options on this window and just click 
on Next to proceed with the installation.

4. Click on Finish on the Installation Complete window to close the installation window. 
5. A shortcut icon for the User Utility will be on your Windows desktop and in the Windows Start All 

Programs menu.

Installing the ISIS Driver

This driver is required for EMC Captiva QuickScan to work properly.
1. You will first be prompted to select a language for the ISIS driver. The language selection on this 

screen only applies to the ISIS scanning interface.
Select the language you want to use then click on Next.

2. Click on Next in the ISIS Installation Welcome window.
3. Click on Install to begin the ISIS driver installation.
4. Click on Finish to close the ISIS installation complete window.
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Installing One Touch

The One Touch software installation will start automatically after you click Close on the driver 
Installation Complete window. One Touch is the software needed for the buttons on the scanner to 
work.
1. Click Next on the Welcome to the One Touch Setup Wizard.

2. On the Visioneer License Agreement window, read the license agreement. If you accept the terms, 
select I Agree then click Next.
If you choose not to accept the license agreement, the installation will terminate and One Touch 
will not be installed.

3. Click Close on the Installation Complete window to close and exit the software installer.

If you selected other software to install from the DVD the installation for that software will 
automatically start after you click Close on the Installation Complete window. Follow the instructions 
on-screen to install each application you selected.
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Register Your Scanner

Registering your scanner is important as it provides you with access to our free telephone support 
service. Registration also gives you free access to software updates for your scanner. 

To register your scanner:

You will need an active internet connection to register your scanner. If you do not have internet access 
you can contact our customer service department to register the scanner. Please refer to the Technical 
Support Card, that you received with the scanner, for our customer service contact information.
1. Open an Internet Explorer window, or any other internet browser you have installed on your 

computer.
2. In the web address field type www.xeroxscanners.com.
3. Press Enter on your computer’s keyboard or click the option on screen to go to the web address.
4. When the Xerox scanners web page loads click on Register Your Product.
5. Fill in the registration form, all required fields have an asterisk (*).

6. You will be asked to enter the serial number for the scanner, it is located on the back or underside 
of the scanner. 

7. After filling in the form, click on Submit Your Registration to complete the registration.

Note: A valid email address is required for registration.
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Installing Additional Applications

Your scanner includes free, additional applications as described in the table below.
1. Return to the disc’s Main Menu and click Install Products.
2. Select the additional applications you want to install, then click Install Now. 

3. Follow the instructions on the screen to install each of the additional applications.

Software About the Software

Adobe® Reader® Adobe Reader is a stand-alone application that you use to open, view, search, and 
print PDF files. This application is located on the disc in the User Guides section.

Nuance 
OmniPage® Pro

OmniPage Pro provides precision OCR analysis, advanced layout detection, and 
Logical Form Recognition™ (LFR) technology. Advanced security features quickly 
turn office documents and forms into over 30 different PC applications for editing, 
searching and sharing. Custom workflows handle large volumes of documents, and 
you can use its tools to print to PDF.

EMC Captiva 
QuickScan™

QuickScan is a stand-alone, out-of-the-box imaging solution that provides all the 
necessary capabilities for high-speed scanning, image enhancement, viewing, 
annotation, printing and storing images. It uses an ISIS-certified driver for scanning 
and includes flexible job separation and barcode recognition. The Demo version lets 
you try the application first.
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Kofax® 
Virtual ReScan® (VRS™)

Kofax VRS automatically enhances scanned documents from less than perfect 
originals. It is an additional scanning interface that uses patented VRS 
(Virtual ReScan) technology, and ensures your scanning is as efficient and easy as 
possible, while also improving the quality of the scanned images. Kofax VRS uses an 
ISIS-certified driver for scanning. This software provides an additional method to 
scan from your scanner. The Demo version lets you try the application first.

At the end of the Kofax VRS software installation you may see the message 
"SVS001: The VRS installation does not install an ISIS driver for the scanner you 
selected. Please install the ISIS driver packaged with your scanner." 

This is not an error, please disregard this message and click OK. The Kofax VRS 
Certified ISIS® driver is installed correctly when you install it with your Xerox 
DocuMate scanner.

Software About the Software
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View the User Guides

1. Return to the disc’s Main Menu and click on User Guides.

The User Guides are in Adobe® PDF format. If you need to, click Install Adobe Reader to install it 
now. Follow the instructions on the installation windows.
If your computer already has Adobe Reader installed, please do not select it unless the version 
provided on the installation DVD is a newer version than the one currently installed on your 
computer. 

2. Click on View scanner documentation to access the scanner user guide.
Click on View software documentation to access the user guides for the software applications 
provided with the scanner. For instance, the Nuance OmniPage user guide is in this section.
From either of these user guide windows, click on the User guide menu button to return to the 
main user guide window, then select the other documentation section to view the user guides.

Scanner documentation window Software documentation window
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3. Click the name of a User Guide you want to view and it will open in Adobe Reader. Use the Adobe 
Save command to save that User Guide on your computer.

4. When you’re finished, click Main Menu to return to the Main Menu window and click Exit.
5. Remove the installation disc and store it in a safe place.

That’s it! Installation is finished and your Xerox DocuMate 4790 is ready to scan.
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5Loading Documents to 
Scan

This chapter includes:
• Items to Avoid Scanning on page 46
• Scanning from the Automatic Document Feeder (ADF) on page 47
• Scanning Interfaces on page 49

After loading documents in the scanner, as described below, you can also scan using the One Touch 
Button Panel on screen, or using a scanning application.

Note: Always remove any staples or paper clips from documents before inserting them into the 
scanner. Staples and paper clips can jam the feed mechanism and scratch the internal 
components. Also remove any labels, stickers, or Post-It™ notes that may come off during the 
scanning process and get stuck in the scanner. Misuse as described here will void your scanner’s 
warranty. 
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Items to Avoid Scanning

The following types of documents can cause multiple-page feeding, paper jams, or damage to the 
scanner.
• Plastic items such as credit cards, identification cards, overhead projector sheets, film, and cloth or 

metallic sheets.
• Photographs or other coated paper as the coating can flake off during the scan process.
• Documents with wet ink, correction fluid, or carbon paper that can leave residue inside the 

scanner.
• Torn, damaged, wrinkled or perforated paper.
• Lightweight paper such as carbon-less paper or tracing paper.
• Irregular paper such as extremely thick card-stock paper, cardboard backing, documents that are 

glued together, paper with tabs, paper with glue residue, extremely smooth or glossy paper, and 
thermal or heat sensitive paper.
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Scanning from the Automatic Document Feeder 
(ADF)

1. Prepare the pages before loading them into the scanner, this helps to prevent multiple-page 
feeding and paper jams.
• If the edges of the paper are curled or folded, flatten them as much as possible.
• Fan the edges of the paper to make sure none of the pages are stuck together.

2. Adjust the paper guide for the width of paper, and make sure the input and output trays are fully 
extended.
Flip up the paper stop to make sure the paper stays in the output area as they are exited from the 
scanner.
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3. Load the documents face up with their tops into the Automatic Document Feeder.
The stack of pages should not exceed the maximum height indicated on the input tray.

4. You can now scan the documents using the scanner buttons, One Touch, or one of the other 
scanning interfaces.
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Scanning Interfaces

If you selected the recommended installation, then you have several different options to scan with 
your Xerox DocuMate 4790 scanner. Each method scans equally well, so use the one with appropriate 
options for the item you are scanning.
• One Touch—When you press either the Simplex or Duplex button, documents are scanned using 

the scan settings indicated by the LCD display. The scanned images are then sent to a software 
application on your computer. See Scanning and Configuring One Touch on page 51.

• One Touch Button Panel—Use this scan option when you want to scan from the computer 
screen. Scanning from the on-screen One Touch Button Panel is the same as selecting a scanning 
option on the scanner, except you click an icon that represents the function. See Scan from the 
One Touch Button Panel on page 54.

• TWAIN Interface—This option uses your scanner’s TWAIN interface to scan. Select scanning 
options before scanning, put the document in the scanner, then click the Scan button in the 
TWAIN interface window. See Scanning from TWAIN on page 139.
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• Windows Image Acquisition (WIA)—This option uses the Microsoft Windows set of choices for 
scanning. Select the WIA scan settings, put the document in the scanner, then click the Scan 
button in the WIA window. See Scanning from WIA on page 157.

• ISIS Interface—This option uses the ISIS interface for scanning. Select the ISIS scan settings, put 
the document in the scanner, then click the Preview Scan button in the ISIS window. See Scanning 
from ISIS on page 161.
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6Scanning and 
Configuring One Touch

This chapter includes:
• Default One Touch Settings on page 53
• Scan from the One Touch Button Panel on page 54
• Changing the Button Settings on page 56
• Selecting Options for One Touch on page 58
• Scan Configurations on page 61
• File Formats on page 69
• Configure Before Scan on page 74
• Open Scanned Document(s) on page 76
• Transfer to Storage on page 77
• Burn to CD-ROM on page 83
• Printer or Fax on page 85
• PaperPort on page 87
• SharePoint on page 89
• FTP Transfer on page 92
• SMTP on page 95
• Email Applications on page 98
• Text Editors on page 100
• Still Image Client on page 105
• Image Editors on page 107
• PDF Applications on page 110
• Send to Application on page 113
• Scanning to Multiple Destinations on page 116
• Scanning with Job Separation on page 119
• Scanning with Optical Character Recognition (OCR) on page 122
• Selecting One Touch OmniPage OCR Options on page 126
• One Touch with Kofax VRS Technology on page 135

Based on the recommended full installation of the scanner driver and the Visioneer One Touch 
software, One Touch is your main scanning interface for using the scanner. 
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The One Touch Button Panel, that you see on the computer screen, shows the pre-set function for each 
button (such as Email) and the icon of the destination (called the Destination Application) where the 
images will be sent when scanning is finished.

The One Touch button panel shows which application 
the button is configured to send images to.
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Default One Touch Settings

When you installed the scanner, the software configured each One Touch button with appropriate 
settings consisting of: a Destination Application, a Scan Configuration, and a File Format. The 
button names, such as Email or Copy, indicate the original factory settings for a button. You can 
change any of these settings. Please see Changing the Button Settings on page 56 for instructions.

For example, the Email button is set up to scan documents then immediately attach them to a 
new email message in your default email program. The email application will default to the 
email program specified in the internet options of Internet Explorer.

A folder icon for a button means that the button is set up to archive the scanned item. The 
scanner sends the scanned image directly to a folder without opening the image first in a 
software application.

A question mark for a button means your computer does not have the appropriate software or 
hardware for the initial factory settings. 

If OmniPage or the One Touch OmniPage Module is not installed, then the options for sending 
to word processing applications such as Microsoft Word will not be available.

Note: The default page size in each configuration is based on your computer’s Windows 
Measurement system selection of U.S. (United States) or Metric units.

• If U.S. is the selected measurement, the default page size in each profile will be based on the 
Imperial standard paper sizes such as 8.5” x 11”.

• If Metric is the selected measurement, the default page size in each profile is based on the ISO 
216 standard and the majority of the profiles will default to A4.
Xerox DocuMate 4790
User’s Guide

53



Scan from the One Touch Button Panel

Scanning from the button panel on your computer’s screen works like pressing a button on the scanner. 
The scanner scans the item, then sends the image to the Destination Application indicated by the 
button’s icon.

To scan from the One Touch Button panel:
1. Load the documents into the scanner.
2. Click on the One Touch icon in the Windows notification area (at the lower right corner of the 

screen.)

3. The One Touch Button Panel opens.

4. Click the button you want to use to scan.
5. The scanner starts scanning and the image is sent to the selected destination for the One Touch 

button you are using to scan.

Features of the One Touch Button Panel

The One Touch panel is your on-screen set of controls for the scanner. From the panel you can access 
the hardware settings for your scanner and configure the Scan button.

Click on the One Touch icon to open the panel. 

One Touch Icon

The Detail View The Hardware View

The Button View
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The Title Bar
• Green arrows—click to cycle through the panel’s 3 views.
• Scanner icon—click to open the scanner’s hardware properties.
• Red “X”—click to close the One Touch panel.

The Button View
• Left-click on a Destination Application icon to start scanning.
• Right-click on a Destination Application icon to open the One Touch Properties.
• Left-click on the arrow buttons, on the right side of the panel, to view the rest of the One Touch 

buttons.

The Detail View
• Left-click on a Destination Application icon to start scanning.
• Right-click on a Destination Application icon to open the One Touch Properties.
• Single-click on the detailed information to open the One Touch Properties.

The Hardware View
• Left-click on the scanner icon to return to the Button view.
• Right-click on the scanner icon to open the scanner’s hardware properties.
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Changing the Button Settings

1. Click on the One Touch icon. 
2. Right-click a button on the One Touch Button Panel.

3. The One Touch Properties window opens.
The One Touch Properties window will also open when you press, hold down for 3 seconds, and 
release a scanner button.

Some of the options on the One Touch Properties Window are “grayed out” and are not available, 
these options are not appropriate for your scanner model.

4. Select the destination you want One Touch to send the scanned image to in the Select 
destination list. 
If you select a word processing program such as Microsoft WordPad or Microsoft Word that can be 
used for OCR (such as TXT or RTF), the text in scanned images is automatically converted to word 
processing text. 

5. Select a file format in the Select format panel.
The formats are based on the type of Destination Application you select. The icon names indicate 
their file types. See File Formats on page 69 for more information about the available formats.

Right-click on a button (for example 
the Scan button) and the Properties 
window opens for that button.

Select the Destination 
Application that will 
open when you are 
finished scanning. You 
use the destination 
application to view 
and work with your 
scanned images.

Select a 
configuration for 
scanning the item. 

Select a file format 
for your scanned 
images.

Scanner button 
configuration tab
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6. Select a scanning configuration in the Select configuration list.
The configuration’s basic settings include: scanning mode, resolution (dpi), page size, brightness 
(Br), and contrast (Cr). To see a selected scan configuration’s settings, click its icon. Click the icon 
again to close the detailed information. Refer to Scan Configurations on page 61 and Configure 
Before Scan on page 74 for instructions on creating and modifying scan configurations.

7. Click on OK to save the changes.
8. Place an item in the scanner and click the One Touch button to start scanning.

The scanner scans and sends the image to the selected destination, with the file format and scan 
configuration you specified.

Properties button—Displays a window for selecting properties for a destination. This button is 
disabled if the selected destination application does not have global configuration properties.

Refresh button—Updates the links between all your computer’s Destination Applications and 
One Touch. If you install new software that can be used as a Destination Application, click the Refresh 
button to link the new software to One Touch.

New/Copy/Edit/Delete buttons—Click New or Copy to add new scan configurations to the list. Click 
Edit or Delete to change or remove them. 

OK/Cancel/Apply buttons—OK accepts any changes and closes the window. Apply accepts any 
changes but leaves the window open so you can continue making additional changes. Cancel closes 
the window without accepting any changes.
Xerox DocuMate 4790
User’s Guide

57



Selecting Options for One Touch

Use the Options Tab to configure how One Touch works with the selected button, such as which 
destinations are available, or what the file name should be. 

Select Button—Click the down arrow and select the button for which you want to modify the settings 
from the list. The options you choose in this window only apply to the button you select in this list.

Show All Destinations—This option selects all of the Destination Application categories. The list of 
Destination Applications available for the selected button will include all the applications on your 
computer that fall into these categories. 

Select Destinations—Select this option to individually choose the types of applications to include in 
the list of Destination Applications. Check the boxes for the type of application to include. 

Destination Categories:
• Document Management includes Nuance PaperPort and other applications for processing and 

keeping track of your scanned documents. This category includes the Send to Application and 
Open Scanned Document(s) destinations.

• Image Editors include Microsoft Paint and other drawing and graphics applications.
• Text Editors include Microsoft Word and WordPad, Microsoft Excel, and other word processing 

and spreadsheet applications. Select this option if you want OCR processing to convert your 
scanned documents to text that you can edit.

• PDF applications are for viewing and/or editing Adobe PDF files.
• Email includes Microsoft Outlook and other email applications, as well as the SMTP destination 

which allows you to scan directly to the SMTP server without opening an email client application.
• Storage and CD-R/W is for scanning directly to a folder on the computer, server, FTP server, 

SharePoint site, or to the Windows CD temp directory for burning the files to a CD.
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• Fax and Print is for sending your scanned documents directly to your printer or fax software. 
• Sti event forwarding is for using another application’s interface for scanning. The One Touch 

Event Forwarding dialog box opens so you can select which application to use to continue 
scanning.

Enable scanning to multiple destinations—select this option to allow for multiple destinations to be 
selected, in the destination list, on the One Touch configuration tab. This feature allows you to scan 
one time while distributing the file to multiple destinations. Please refer to Scanning to Multiple 
Destinations on page 116.

Instant Delivery—enables image transfer to the destination while scanning is in progress, provided 
that “Create Single Image Files” is also selected. If Create Single Image Files is not selected, image 
transfer occurs after all pages have been scanned.

Show Progress Window—select this option to display the progress window of the document(s) during 
scanning.

Use job separator when scanning multiple pages—select this option to have the scanner separate 
multiple page scan jobs into separate files when scanning is complete. 
• When a blank page is detected—select this option to have a new file created each time a blank 

page is detected in the stack of pages being scanned. Note that when scanning Duplex, both sides 
of the page must be blank.

• When the number of images reaches—select this option, and input a number in the box, to have 
a new file created each time the number of images scanned reaches the number you input in this 
field. Note that when scanning Duplex, the number of images detected is twice the number of 
pages scanned. For example, if you input “5” in the field, and scan 10 pages, 20 images are 
captured, and you will get 4 separate files with 5 images in each file.

Please refer to Scanning with Job Separation on page 119 for detailed information about scanning 
with job separation, and how it works with other options in One Touch.

Use custom file naming—Select this option to enable the input field so that you can specify the file 
name for your scanned document(s). You can specify a different file name for each One Touch button. 
When this option is not select, the file name is automatically generated by One Touch for all scans.
• The preview area, to the right of the Use custom file naming text, shows an example of the 

filename as you type into the input field and/or select token options from the list.
• Type the file name you want into the input field. Note that you cannot input these characters in a 

file name: \ / : * ? “ < > |
When inputting a file name, the file name must be unique, otherwise every scan created would 
overwrite the previous scan. The menu to the right of the input field contains a list of tokens you 
can select to create unique file names. These tokens include counting numbers, date and time 
values, number of pages scanned, and so on. If the button name is not unique, you will see an on-
screen notification that a {BatchID} and/or {#b} will be inserted into the name. 
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• Click the down arrow and selected a token value from the list, then click the arrow button to add 
that value to the file name field. The token values are:
{FN}—inserts the scanner name.
{#b}—inserts the image number without adding zero (1).
{#03b}—inserts a 3-digit image number in the scan batch (001).
{D}—inserts the numeric day of the month without a zero added to single-digit days (4).
{DD}—inserts the numeric day of the month with a zero added to single-digit days (04).
{DDD}—inserts the abbreviated 3-letter day (Mon).
{DDDD}—inserts the full name of the day (Monday).
{M}—inserts the numeric month without a zero added to single-digit months (8).
{MM}—inserts the numeric month with a zero added to single-digit months (08).
{MMM}—inserts the abbreviated 3-letter month (Aug).
{MMMM}—inserts the full name of the month (August).
{YY}—inserts the two-digit year (97).
{YYYY}—inserts the four-digit year (1997).
{h}—inserts the 12-hour clock hour without a zero added to single-digit time values (2).
{hh}—inserts the 12-hour clock hour with a zero added to single-digit time values (02).
{H}—inserts the 24-hour clock hour without a zero added to single-digit time values (2).
{HH}—inserts the 24-hour clock hour with a zero added to single-digit time values (02).
{m}—inserts the minute without a zero added to single-digit time values (7).
{mm}—inserts the minute with a zero added to single-digit time values (07).
{s}—inserts the second without zero added to single-digit time values (9).
{ss}—inserts the second with zero added to single-digit time values (09).
{User}—inserts the user name.
{Mach}—inserts the computer name.
{Dest}—inserts the destination application name.
{Bttn}—inserts the button name.
{Mode}—inserts the scan color mode.
{Size}—inserts the page size.
{BatchID}—inserts a unique batch identification number.

Technical Note

Some destination application links, such as the NewSoft Presto! BizCard software, require a specific 
filename format for the images that have been sent to the link to open correctly in the application. For 
example, when scanning duplex, if the image token {#03b} is not included in the filename, then each 
image sent will be regarded as a separate scan, and instead of one file with 2 pages you will have 2 
files. As each destination application link is different, there is no standard filename type you can create 
to use for all destinations. If you scan and the images are not grouped in the file(s) as needed, try 
deselecting “Use custom file naming” and then scan again.
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Scan Configurations

The scan configurations are where you select the scanning resolution, brightness, mode (color, 
black&white, or grayscale), and a number of other settings. To see a selected scan configuration’s 
settings, click its icon. Click the icon again to close the detailed information. 

Note: Use Configure Before Scan if you want to set the options manually before scanning. See 
Configure Before Scan on page 74.

Create a new configuration:
• Click the New button to create a new configuration starting with the One Touch default 

configuration settings.
• Select a configuration in the list, then click on the Copy button to create a new configuration 

starting with the settings of the currently selected configuration.

Edit or delete a configuration:

Select the scan configuration you want to edit or delete. 
• To delete the configuration, click the Delete button.
• To edit the configuration, click the Edit button.

Edit the settings and click OK.

Note: Your scanner comes with a number of configurations pre-set at the factory. To ensure that your 
scanner will always have a set of correct scan configurations, do not delete the pre-set configurations. 
We also recommend that you keep those configurations locked so they are not inadvertently deleted. 
That way, you will always have the factory-settings available. If you do delete or edit them, and want 
to get the factory pre-sets back again, you will need to uninstall then re-install your scanner.

Click the icon of a 
selected configuration 
to view its settings.

Select the scan configuration 
to edit or delete. It must be 
unlocked, as indicated by not 
having a lock displayed here.
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In the Scan Configuration Properties window, the Scan Settings, Page Settings, Advanced Settings, 
and Redaction Settings tabs are always available. When the Kofax VRS module is installed, the VRS 
Settings tab will also be available for all destinations. 

Based on the selected destination, additional settings tabs may also be available. If you see one of 
these additional settings tabs please refer to the appropriate section, as listed below, for instructions 
on configuring these destination specific options.
• Use the Storage Options tab to choose the storage folder for scans sent to the Transfer to 

Storage destination, as described on page 77.
• Use the Device Settings tab to configure Printer or Fax destinations, as described on page 85.
• Use the PaperPort tab to choose the destination folder, in the Nuance PaperPort application, as 

described on page 87.
• Use the SharePoint tab to specify a SharePoint site, user credentials, and destination folder, as 

described on page 89.
• Use the FTP Settings tab to specify an FTP site, user credentials, and destination folder, as 

described on page 92.
• Use the SMTP Configuration tab to specify an SMTP server, user credentials, and destination 

email address, as described on page 95.

Scan Settings Tab

On the Scan Configuration Properties dialog box, type a name. 

Mode—Select a scanning mode:
• Black&White to scan in black and white. For example, letters and memos are usually scanned in 

black and white.
• Grayscale to scan items such as documents containing drawings or black and white photographs.
• Color to scan color photographs and other color items. Color scans have the largest file size.

Resolution—Drag the slider to the right or left to adjust the dots per inch (dpi) of the resolution. The 
higher the dpi setting, the sharper and clearer the scanned image. However, higher dpi settings take 
longer to scan and produce larger files for the scanned images.

If the configuration is 
locked, click the lock 
to unlock it. The icon 
becomes a key.

Type a new name for the 
configuration.

Select the scan mode 
and drag the slider to set 
the resolution.

Drag the sliders to set the 
Brightness and Contrast.
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Brightness—Sometimes an image is scanned with the brightness and contrast set too light or too 
dark. For example, a note written with a light pencil may need to be scanned darker to improve 
legibility. Increasing or decreasing the brightness makes the scanned image lighter or darker.

Contrast—The difference between the lighter and darker portions of the image. Increasing the 
contrast emphasizes the difference between the lighter and darker portions, decreasing the contrast 
de-emphasizes that difference.

Key and Lock icon—If you want to lock the configuration, click the key icon to change it from a Key to 
a Lock.

Page Settings tab

The options on the Page Settings tab will be available based on either the selected color mode (Black & 
White, Grayscale, or Color), or based on whether or not the scanner hardware supports the feature. 

Standard—Click the menu arrow and choose a page size from the list.

Custom—Enter the horizontal and vertical page dimensions in the boxes. Click the name of the units, 
inches or millimeters, to toggle between them.

Improvements and Settings—It is indicated in the feature description if there is a software or 
hardware dependency for the option to be available.
• Duplex—Scan both sides of the page. This option is only available if the scanner supports this 

feature. 
The Simplex and Duplex buttons on the scanner take precedence over the One Touch settings. In 
other words, if the LED number on the scanner is configured to scan as Duplex, but you press the 
Simplex button, the scanner scans in Simplex, and vice versa.

• AutoCrop to original—Select this option to let the scanner automatically determine the size of 
the item being scanned. This option is only available if the scanner supports this feature.
Always use the paper guides on the scanner so the page is not skewed. Skewed pages may not 
crop properly.

Click the name to 
toggle between inches 
and millimeters.
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• Reduce moiré patterns—Moiré patterns are wavy, rippled lines that sometimes appear on the 
scanned images of photographs or illustrations, particularly newspaper and magazine 
illustrations. Selecting Reduce moiré patterns will limit or eliminate moiré patterns in the scanned 
image. This option is only available when scanning in Color or Grayscale at lower resolutions, and 
when the scanner supports this feature. 

• Straighten image—Select this option to let the scanner automatically determine if a page is 
skewed, then straighten its image. This option is only available if the scanner supports this feature.
If you are scanning using an Automatic Document Feeder, and the page is fed through at too 
great of an angle, the image may not straighten correctly. In that case, re-scan the page using the 
paper guides to feed the paper in straight. 

• Autorotate 90—Select this option to rotate the scanned image 90 degrees clockwise when 
scanning is finished. Typically, you might use this option if the pages you are scanning pages that 
are printed in landscape, such as financial spreadsheet data. This option is only available if the 
scanner supports this feature.

• Invert image—Only available for Black&White Mode, this option reverses the black and whites of 
an image.

• Skip blank originals—Select this option to have the scanner detect if a blank page has been fed 
through the scanner, and remove it from the final file. Typically you might use this option when 
scanning a stack of two-sided pages which have a number of blank sides.
Sensitivity—You can adjust the sensitivity level of the blank image detection. For instance, if you 
are scanning double-sided light-weight paper, the scanner may not detect a blank side as text or 
images, from the opposite side of the page, may appear in the scanned image. In that case, lower 
the sensitivity level for more accurate results.
Note that when the Options tab feature Use job separator in multi-page batch is enabled, and 
the option selected is When a blank page is detected, the sensitivity level for Skip Blank Originals 
is the sensitivity level that will be used when both features are enabled. 
Note that when the feature Use job separator in multi-page batch is enabled, and the option 
selected is When the number of images reaches, the blank originals are discarded before the 
images are counted. For example, if you scan 3 pages in duplex mode, each side of the page is 
counted as an image and the total number of images is 6. When Skip Blank Originals is enabled, 
and 2 of the 3 pages in the stack are blank on one side, the total number of images counted is 4 
not 6.

Original Image Inverted Image
Xerox DocuMate 4790
User’s Guide

64



• Color Filter—Color filter is the ability of your scanner to automatically remove a color from a 
scanned image. For example, if you are scanning a letter with a red watermark, you can choose to 
filter out the red so the scanned letter just shows the text and not the red watermark. Color filter 
applies to Black & White or Grayscale scanning modes. 

• Double Feed Detection—Selecting this option turns on the scanner hardware feature that 
detects when multiple pages feed through the scanner at one time. This option is only available if 
the scanner supports this feature.
Abort—scanning stops and all pages scanned in this batch, up to this point, will be deleted.
Prompt—you will be prompted to remove the pages in the ADF, restack the remaining pages and 
continue scanning. All pages scanned before and after the double page feed are saved. 

Advanced Settings tab

Use the Advanced Settings tab to set color correction options for Color or Grayscale scanning. Drag 
the sliders to the left and right to change the color settings. As you do, the image changes to show the 
effects of the new settings.

• Color saturation—the strength or purity of a color. This option is only available when the selected 
scan mode is Color.

• Color hue—the color your eyes see as reflected from the image. This option is only available when 
the selected scan mode is Color.

• Gamma—is the tone curve and the starting point for image enhancement. As you raise or lower 
the Gamma value, the values at which saturation, hue, brightness and contrast affect the image 
are changed. It is recommended that you keep the default Gamma value or adjust this setting 
before adjusting the other options. This option is available for both Color and Grayscale scanning.

The original with a red 
watermark over black text.

The scanned item with the 
red filtered out.
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Redaction Settings Tab

Use the options on the Redaction Settings tab to remove a specified area in the scanned image. 

Please refer to the technical note, at the end of this section, for information about how this setting 
works with other options in the One Touch Scan Configuration you are modifying. 

Enable redaction—Select this option to enable redaction when scanning. You might use this option if 
you want to remove a logo or image that appears on each page that you are scanning. You can choose 
what color to fill in the redacted area in the scanned image, and set multiple areas. If you are scanning 
in Duplex mode, you can specify the area separately for the front and back side of the pages.

Click Add to add a line item to the area list in this window. You can redact multiple areas from the 
scanned image, click the Add button again to continue adding line items to the list. Select an item in 
the list then click the Remove button to remove the specified redaction area from the list.

Side—Click once on the word Front to show the Side option list. If you are using a simplex (one-sided) 
scanner, only the Front option will be available. If your scanner supports duplex (two-sided) scanning, 
the options Front, Back, and Both will be available in the list.

• Front—This is the Simplex side of the page. The area(s) specified for the Front will only apply to 
the Simplex side of the page when scanning in Duplex. Therefore, if you scan 4 double-sided 
pages, the resulting image file(s) will have redacted areas on pages 1, 3, 5, and 7.
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• Back—This is the Duplex side of the page. The area(s) specified for the Back will only apply to the 
Duplex side of the page when scanning in Duplex. Therefore, if you scan 4 double-sided pages, the 
resulting image file(s) will have redacted areas on pages 2, 4, 6, and 8.

• Both—Select this option if you want to specify an area that appears in the same place on both 
sides of the page, such as a company logo, so you don’t have to specify the same area separately 
for both the front and back.

Click one time on the default value, 0.00 in each field, to enable the control box for you to input the 
start position and redaction area size. The units of measurement is displayed on the lower-right corner 
next to the Paper size field.

• From left—Input the upper-left corner start position measured from the left-side of the page.
• From top—Input the upper-left corner start position measured from the top of the page. 
• Width—Input the width of the area to be removed.
• Height—Input the height of the area to be removed.

Color—This color field shows the selected fill color for the redacted area(s). When the software 
removes the area you specify, it fills the area with the color you have selected here. To change the 
color, click the artist palette button to open the Windows color palette. Select the color you want then 
click on OK. The color you selected will now display in the Color field on the Redaction Settings tab.
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Preview—This color field shows the actual color that will fill the redaction area in the final scanned 
image. When scanning in color, the Preview field will match the Color field. When scanning in 
Grayscale, the preview field will show the gray version of the color you selected, and that color will be in 
the final scanned image. When scanning in Black&White, the preview field will display black or white 
depending on the darkness of the color you selected, and the final image will have the redacted area(s) 
be black or white.

Technical Note:

The options on the Page Settings tab will affect the redaction options as described below:
• On the Page Settings tab, click the name inches or mm to toggle between the two units of 

measurement. When you click back on the Redaction Settings tab, the lower-right corner displays 
the Paper size in the units of measurement you selected.

• Make sure the page size selected on the Page Settings tab is correct for the documents you are 
scanning, otherwise the redaction may not occur in the correct area.

• If Color Filter is selected, redaction occurs after the color specified is removed from the image. 
For example, if you selected Red as the color dropout, but then specify red for the redaction 
region, the final image will have the redacted region filled with gray when scanning Grayscale, or 
black or white when scanning in Black&White. 

• If Autorotate 90 is selected, redaction occurs after the page has been rotated. When inputting 
the position and area for redaction, use the measurements of the page in the landscape position. 

Color 
scanning

Grayscale 
scanning

Black&White 
scanning

Click the name to 
toggle between inches 
and millimeters.
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File Formats

The available file formats, in the Select format panel, are based on the selected destination for 
scanning. For example, if scanning to the destination Transfer to Storage, all file formats are available 
as the files are saved directly to a folder without opening any application. If the destination is an 
application, such as Microsoft’s Paint, only the file types the application supports will be available in 
the Select format panel. 

Most of the format icons have a right-click menu to select file format specific options, or choose 
additional formats that are not represented in the panel by default. 

The format names in the Select format panel indicates the file type extension for the scanned file.

Create Single Image Files

The TIFF and PDF formats, as well as the text file formats, support multiple page documents in a single 
file. If you are scanning as a TIFF or PDF format, or as one of the text formats, and want one file 
created for each image scanned, select Create single image files. Note that this option is 
automatically selected and disabled if you have selected a format that only supports single pages, such 
as BMP, PNG, GIF, JPG, or JP2.

Image Formats. The BMP, JPG, and 
PDF image formats have right-click 
menu options.

Text Formats; 
TEXT is only 
one of several 
text formats 
available.
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Image Formats

Select an image file format for photos, artwork or other documents that you want to save as images. 
BMP and TIFF are standard image file formats generally used if you want to do additional image 
processing, such as photo touch-up or color correction. 

Right-click on the BMP icon to access the GIF and PNG image formats. When you select either of these 
formats, the format panel will change the BMP icon to the selected image format icon.

BMP—The *.bmp (bitmap) format is generally used when you want to do additional image processing, 
such as photo touch-up or color correction, as very little image compression is used when creating the 
file. When scanning in color or grayscale, BMP scans result in the largest file size of the image formats.
GIF—The *.gif (graphics interchange format) format is generally used when putting images on a website 
or server, as image compression can reduce the file size by approximately 95% when compared to a BMP 
file of the same image. Company logos and small pictures on a webpage are often GIF images. The GIF 
compression, and limited color range, can result in the medium and large images looking grainy or pixi-
lated. 
PNG—The *.png (portable network graphics) format is another common image format for website 
graphics. Like GIF, the PNG compression greatly reduces the file size when compared to a BMP file of the 
same image. However, the PNG compression is different from GIF compression in that PNG images look 
better when scaled. Therefore, PNG is often used in place of GIF for company logos with a lot of detail, 
clickable buttons, medium sized pictures, and so on.
TIFF—The *.tif (tagged image file format) format is another image type that is often used for photo 
editing. When scanning in color, it produces a file of similar quality and size to a BMP file. However, when 
scanning in Black & White, the TIF compression produces the smallest file size of all the image types 
without losing image quality. TIFF also supports multi-page image files.
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Right-click on the JPG icon to access the JP2 image format. When you select JP2, the format panel will 
change the JPG icon to the JP2 format icon.

To select a JPEG file size:

1. Select JPG as the page format. 
2. Right-click on the JPG icon.

A menu opens.

3. Choose the file size/image quality option for your scanned images.
Minimize Size—Smallest file size, lowest image quality.
Normal—Medium file size, some loss of image quality.
Maximize Quality—Largest file size, minimal loss of image quality.
Your selection pertains only to the button currently selected on the One Touch Properties window. 
Other buttons that have JPG selected as the file format are not affected, so you can set the JPG 
file size/image quality independently for each button.

4. Click OK or Apply on the One Touch Properties window.

JPG—The *.jpg (joint photographic experts group) format is a common image format for transferring 
pictures electronically, such as posting to a website or sending via email, as JPG image files are smaller 
than BMP and TIFF files. You can change the level of compression for the picture file to have better qual-
ity or a smaller file size.
JP2—The *.jpg2 (joint photographic experts group 2000) format is the new JPEG standard. This new JPG 
file type has improved compression for better image quality at smaller file sizes. Please refer to the offi-
cial JPEG website at www.jpeg.org for more information about this file format, and a list of applications 
that can view and/or open this file type.
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Right-click on the PDF format icon to change the image quality or select the option to make the 
scanned PDF file PDF-A compliant. 

To select a PDF file size:

1. Select PDF as the page format. 
2. Right-click on the PDF icon.

A menu opens.

3. Choose the file size/image quality option for your scanned images.
Minimize Size—Smallest file size, lowest image quality.
Normal—Medium file size, some loss of image quality.
Maximize Quality—Largest file size, minimal loss of image quality.
Your selection pertains only to the button currently selected on the One Touch Properties window. 
Other buttons that have PDF selected as the file format are not affected, so you can set the PDF 
file size/image quality independently for each button.

4. Click OK or Apply on the One Touch Properties window.

Text Formats

Selecting the text format option also selects OCR processing as an automatic step for scanning. 
Therefore, when you scan a document with the text format selected, the text portions of the document 
are automatically converted to editable text. 

Select a text format for documents with text or numbers, such as a business letter, report, or 
spreadsheet. The text format icon has several file formats available, depending on the Destination 
Application you select.

PDF—the *.pdf (portable document format) image format is often used to create images of text pages. 
The image compression of PDF files creates relatively small file sizes when scanning multiple page files in 
color. While the TIFF image format also supports multiple page files, when scanning in color the TIFF 
files are often too large to be transferred electronically. The PDF file format is often used for posting mul-
tiple page files to websites, sending via email, and permanent storage. As with the JPG file format, you 
can change the PDF quality to reduce the file size or improve the image quality. 
Adobe® Reader®, or other PDF viewer software, must be installed on your computer for you to to view 
PDF files. 
Using PDF-A when scanning as PDF, means the files are compliant with the ISO-19005-1 standard for 
permanent archival of electronic documents. More information about this standard can be found at 
www.pdfa.org.
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Detailed information about these text file formats, and instructions for setting up the OCR options, are 
in the section Scanning with Optical Character Recognition (OCR) on page 122.

To select a file type for the text format:

1. Select the Destination Application.
2. Right-click on the text format icon. 

The menu options depend on the type of Destination Application you select.
3. Choose the file type that you want for the text format.
4. Click OK or Apply on the One Touch Properties window.
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Configure Before Scan

You can set up the scanner so that, when you press a button or click it on the Button Panel, a different 
scanning interface opens before the scanning starts. To set up the scanner for this capability, you select 
Configure Before Scan from the scan configuration list.

Choosing Configure Before Scan simply opens either the TWAIN or WIA scanning interface when you 
press a button. You can then use the interface to change the Resolution, Scan Mode, and other 
settings. When you scan, the scanned image will still be sent as the file type and to the same 
Destination Application already selected in the One Touch Properties window for that button. 
1. Open the One Touch Properties window.
2. Select the scan configuration Configure Before Scan. 

3. Right-click on Configure Before Scan and choose an interface to use for configuring before 
scanning.
TWAIN—The TWAIN Interface opens for you to make changes prior to scanning. See Scanning 
from TWAIN on page 127.
WIA—The Windows Image Acquisition (WIA) Interface opens for you to make changes prior to 
scanning. See Scanning from WIA on page 157.

4. Click OK or Apply on the One Touch Properties window.

To Scan Using Configure Before Scan

1. Click the button you set up to use Configure Before Scan.
2. The TWAIN Interface opens.
3. Choose your scan settings, such as the Picture Type of Color, Grayscale or Black & White, 

Resolution in DPI, and Page Size.

Select then right-
click on Configure 
Before Scan to 
get the menu, 
and choose the 
interface to use 
for scanning.
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4. Click the Scan button on the TWAIN Interface.
5. The item is scanned. When finished, click the Done button and the image will be sent to the 

Destination Application specified in the One Touch Properties window.
In the example shown on the previous page, the Destination Application is Paint. 

Canceling a Configure Before Scan

1. Click Cancel in the scanning progress window.

2. The following window will open asking if you want to cancel the entire job.

• Yes—Scanning stops and all pages scanned in this batch, up to this point, will be deleted. The 
TWAIN interface will close and you can restart your scan from the beginning.
Choose Yes if the TWAIN scan settings are incorrect for your current scanning batch. 
For instance, the Picture Type is Black & White but you want to scan your documents in color. 
Choose Yes to delete any scanned pages, then start over but select the correct picture type 
before scanning.

• No—Scanning stops, but all pages scanned in this batch, up to this point, are not deleted and 
the TWAIN interface remains open. You can place a new page in the scanner, adjust the 
TWAIN settings for it, then click the Scan button in the TWAIN interface to continue 
scanning. At the end of the scanning batch, all pages from the first portion of the scan and 
second will be sent to the Destination Application. 
Choose this option if, for instance, you have been scanning a Black & White document but 
you want to insert a color page into it. Instead of having to re-scan the entire batch, you can 
stop the current scan, change the picture type from Black & White to Color, then restart the 
scanning without losing the pages already scanned.
Xerox DocuMate 4790
User’s Guide

75



Open Scanned Document(s)

Select the destination Open Scanned Document(s) to have the scanned document open 
automatically when scanning is complete. 

Supported file types—All file formats are available when scanning to the Open Scanned Document(s) 
destination. Note that text file formats are only available if an OCR module or application is installed. 
Please refer to Text Formats on page 72 to see a list of text file formats that are available when OCR is 
installed.

Destination type—The Open Scanned Document(s) destination is classified as a “Document 
Management Link”. To make it available in the destination list, you must select Document 
management on the Options tab in the One Touch Properties window.

Technical Note:
• If there is no application installed for the file format you selected, the One Touch Link Log Viewer 

will open when scanning is finished showing the failure. You can double-click on the log failure to 
open the detail view of the failed transfer. 
For example, if you select PDF as the file type a PDF viewer application must be installed to open 
the file. 
Either install an application for that file type, or associate an application in the Windows Explorer 
folders option, please refer to your Windows documentation for instructions on associating file 
types. 

• When scanning to multiple destinations, the scanned file is still sent to the other selected 
destination application(s) in One Touch. 
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Transfer to Storage

With Transfer to Storage, you can scan documents and save them in a folder in one step. 

Supported file types—Since the files are saved directly to a folder on the computer or server, all file 
formats in One Touch are available. Note that text file formats are only available if an OCR module or 
application is installed. Please refer to Text Formats on page 72 to see a list of text file formats that are 
available when OCR is installed. 

Destination type—The Transfer to Storage destination is classified as a “Storage Link”. To make it 
available in the destination list, you must select Storage and CD-R/W on the Options tab in the 
One Touch Properties window.

Setting the Folder and Options from One Touch

In the One Touch Properties window, select Transfer to Storage as the Destination Application for 
scanning. 

• Click the Properties button to open the One Touch Link Properties for Transfer to Storage. From 
this window, you can change the global default storage location and options.
On initial installation of One Touch, all scan configurations use these settings. When you create 
new configurations, the default settings will also match what you have selected here. If you 
modify the storage options in an individual configuration, changing the options in this Link 
Properties window will no longer update to the configurations you modified.

• Click the New, Copy, or Edit button to open the Scan Configuration Properties window. Click on 
the Storage Options tab and use this window to set a configuration to scan to a different folder 
than the one selected in the Link Properties window.
Changing the options in this window only affects the configuration you are creating or modifying. 
All other configurations will retain their settings for this destination. 
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Storage layout
• All documents are in the root—The scanned documents are saved in the root of the folder 

specified in the Storage location.
• Documents are put into folders by month, week, or type—Folders are created based on your 

selection (month, week, or file type) and the scanned documents are saved in those folders. New 
folders are created for each month and week so you can keep track of when you scanned the 
documents. 

Storage location
• This is the location on the computer or network where the file will be saved. Click on the Browse 

button to change the location by browsing through your Windows folder list, or type a location 
directly into the input field. You can select a local folder, or a folder on a server or mapped drive.

Open storage folder when scan is complete
• Select this option to have the folder, specified in the Storage location, open when scanning is 

complete and the image has been transferred to that location. If you have selected a month, 
week, or type grouping option, the folder that opens will be the grouping option you selected. 

Setting the Folder from Windows

When One Touch was installed, a storage option was added to the right-click menu of your Windows 
folders. This menu option allows you to set the Transfer to Storage folder location without opening 
One Touch first. 
1. Right-click on the folder you want set as the scan destination.

Transfer to Storage One Touch Link Properties window

Scan Configuration Properties window - 
Storage Options tab
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2. Hover the mouse cursor over the Set as scan destination option and the sub-menu will open to 
the right. Click on the setting you want the Storage location to be updated with. 

• For all configurations—select this option to have the storage location, in all scan 
configurations Storage Options tabs, updated to use this location. Note that the storage Link 
Properties location will also update to use this location.

• For new and default configurations—select this option to have the One Touch Link 
Properties storage location updated. Any scan configurations that you have not previously 
updated, with custom storage locations, will also use this location.

• For configuration used by a button—when you select this option, another sub-menu will 
open to the right. The sub-menu will contain a list scanner buttons that are currently set to 
scan to the Transfer to Storage destination. Select the button you want updated to use this 
location. This option modifies only the scan configuration that is assigned to the button you 
select. If you have multiple One Touch 4.6 scanners installed, the first sub-menu will show a 
list of the currently connected scanners for you to select which scanner to update.
Note that this option is disabled if there is no scanner plugged in and turned on. 

Scanning to Multiple Folders

When archiving documents with Transfer to Storage option, you can scan the documents to different 
folders. For example, one folder might be for “Business Receipts,” a second folder might be for “Personal 
Receipts,” and a third folder might be for “Annual Receipts.”

To scan to multiple folders, you create multiple configurations, each with a different storage location 
for the scanned documents. Scan one set of documents using the scan configuration with the 
appropriate storage location for that set. Then switch to another scan configuration and scan the next 
set of documents to store them in their folder.

Setting up multiple folders for transfer to storage

1. Using Microsoft Windows, create the folders that you want to use for storing scanned items. 
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2. Open the One Touch Properties window.
3. Select Transfer to Storage as the Destination Application.
4. Click the New button.

The Scan Configuration Properties dialog box opens.
5. To help you remember which folder it is, give the new configuration a name that indicates the 

folder name, such as “Business Receipts.”
6. Click the Scan Settings, Page Settings, and Advanced Settings tabs, and select the settings you 

want.
7. Click the Storage Options tab.

8. Click the Browse button.
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9. Select the folder you created for storing the scanned documents.

10. Click OK. The selected folder will now be set as the Storage Location, such as “Business Receipts.”

11. Click OK. The new configuration is now listed as a Transfer to Storage configuration.
12. Repeat the process to create additional new configurations, such as one named “Personal 

Receipts.”
Note: Make sure to designate separate folders as the Storage Locations for each new 
configuration.
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13. You will now have multiple configurations set up for the Transfer to Storage destination, and each 
configuration scans documents to separate folders.

14. Now select a scanner button for each new configuration. Click Apply to set that button for that 
configuration.

Scan to multiple storage folders:
1. Insert the document you want to scan to storage.
2. Start scanning with the first button that you set to scan documents and transfer to storage.
3. When scanning is complete, insert the next set of documents in the scanner, then press the second 

button you set to scan documents and transfer them to storage.
4. When scanning is finished, the documents are stored in the two separate folders.

The new configurations 
apply to the Transfer to 
Storage Destination 
Application.
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Burn to CD-ROM 

If you have a CD burner attached to your computer, you can scan directly from your scanner onto a CD. 
This feature is available only on computers running Windows version XP or later. 

Supported file types—Since the files are going to be burned to a CD, all file formats in One Touch are 
available. Note that text file formats are only available if an OCR module or application is installed. 
Please refer to Text Formats on page 72 to see a list of text file formats that are available when OCR is 
installed.

Destination type—The Burn to CD-ROM destination is classified as a “Storage Link”. To make it 
available in the destination list, you must select Storage and CD-R/W on the Options tab in the 
One Touch Properties window.

1. Open the One Touch Properties window.
2. Select Burn to CD as the Destination Application. 

3. Choose a File Format and a Scan Configuration.
4. Click OK.
5. Now start scanning using the scanning button you set to scan and burn to a CD.

The scanner will start scanning. When finished the file will be saved to the Windows temporary 
location for CD files. An information bubble will appear in the Windows notification area telling 
you that there are files waiting to be burned to CD.
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6. When you are ready to burn the files to a CD, open the One Touch Properties window, select Burn 
to CD and then click the Properties button. 

7. Make sure a blank CD is in the CD burner.
8. Click the Burn to CD button. The CD burner begins and your scanned documents are written to 

the CD.
If other files are also waiting in this location, they will get written with the One Touch files on the 
CD.
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Printer or Fax

The availability of printers and/or faxes in the One Touch destination list depends on whether or not 
you have printers or faxes configured in Windows. Please refer to the Windows documentation, or your 
printer or fax documentation, for setting up printers and faxes. 

Supported file types—Only the BMP file format is available, when scanning to a printer or fax, as only 
uncompressed data can be send to these devices.

Destination type—Printers and Faxes are classified as “Device Links”. To make them available in the 
destination list, you must select Fax and Print on the Options tab in the One Touch Properties window.

The Properties button will be disabled in One Touch as there are no global properties for this type of 
destination. 

Select a printer or fax device, in the Select destination list, then open a Scan Configuration to modify 
the settings for the device you selected.
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Click on the Device Settings tab and use the options on this tab to select settings for the device.

• Fit to page, reduce image if necessary—If the scanned image is too big to be printed or faxed 
on a single page, the image will automatically be reduced to fit the page.

• Actual size, crop image if necessary—If the scanned image is too big to be printed or faxed on a 
single page, the image will automatically be cropped around its edges to fit on the page.

• Center image on page—The image will be printed in the center of the page instead of at the top 
left corner.

• Maintain aspect ratio—The aspect ratio is the length-to-width relationship of the image’s 
dimensions. Select this option so the image’s relative proportions remain constant.

• AutoRotate image for best fit—If the image is a Landscape format and the device is printing in 
the Portrait mode, or vice versa, rotate the image to fit on the page.

• Collate copies—If you are printing more than one page, collate the copies. Enter the number of 
copies in the Copies box.

• Advanced—Click to see additional settings for the device. The dialog box that opens is specific to 
the device. For example, if the device is your printer, the dialog box is your printer’s setup settings.

Note: When scanning to multiple printers and/or faxes, select the specific device, you want to 
configure the Advanced features for, from the list before clicking on the Advanced... button.
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PaperPort

In the One Touch Properties window, select PaperPort as the Destination Application for scanning. 

Supported file types—All image file formats are available when scanning to PaperPort. The sPDF and 
nPDF text file formats are only available when the OmniPage software or One Touch OmniPage 
module is installed. Please refer to Text Formats on page 72.

Destination type—The PaperPort destination is classified as a “Document Management Link”. To 
make it available in the destination list, you must select Document management on the Options tab 
in the One Touch Properties window.

• Click the Properties button to open the One Touch Link Properties for PaperPort. From this window, 
you can change the default folder location and options.
On initial installation of One Touch, all scan configurations send the scanned document to the 
folder selected in this window. When you create new configurations, the default settings will also 
match what you have selected here. If you modify the options in an individual configuration, 
changing the options in this Link Properties window will no longer update to the configurations 
you modified.

• Click the New, Copy, or Edit button to open the Scan Configuration Properties window. Click on 
the PaperPort tab and use this window to set a configuration to scan to a different folder than the 
one selected in the Link Properties window.
Changing the options in this window only affects the configuration you are creating or modifying. 
All other configurations will retain their settings for this destination. 
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Select the destination folder for Scanned Documents
• Select a folder to send the scanned document(s) to when scanning to the PaperPort destination.

The list of folders in this window are from the PaperPort Folder Manager. Use the PaperPort Folder 
Manager to add or delete folders, add other drives and network locations to this list. You cannot 
add new folders from the One Touch PaperPort configuration windows.

Scan to the current PaperPort folder
• Select this option to have the scanned document(s) sent to the currently selected folder in the 

PaperPort application.
The PaperPort software must be open, before scanning, for the scans to be sent to the selected 
folder in the PaperPort folder pane. If PaperPort is not open, this option is ignored and the scanned 
file is sent to the folder selected in either the One Touch Link Properties or Scan Configuration 
window for PaperPort.

PaperPort One Touch Link Properties window

Scan Configuration Properties window - 
PaperPort tab

These are the folders that are 
available in the One Touch PaperPort 
configuration windows. Press F1 on 
your keyboard to open the PaperPort 
help file for instructions on managing 
this folder list.

Click the folder icon to open or close 
the folder list in PaperPort.

The selected folder in this list is where 
the scanned file will be saved when 
PaperPort is open and the One Touch 
option Scan to the current PaperPort 
folder is selected.
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SharePoint

The SharePoint destination link allows scans to be sent directly to a SharePoint site from One Touch. 
Please contact your SharePoint site administrator for the server information you need to configure this 
link. Alternatively, have your site administrator or IT professional configure this link for you. Setup and 
configuration of the SharePoint sites and user accounts are outside the scope of this document.

Supported file types—All image and text file formats, except HTML, are available when scanning to 
the SharePoint site. Note that text file formats are only available if an OCR module or application is 
installed. Please refer to Text Formats on page 72 to see a list of text file formats that are available 
when OCR is installed.

Destination type—The SharePoint destination is classified as a “Storage Link”. To make it available in 
the destination list, you must select Storage and CD-R/W on the Options tab in the One Touch 
Properties window. 

All configuration of the SharePoint server is done using the SharePoint settings tab in the Scan 
Configuration Properties window. 
1. Select SharePoint as the destination application.
2. Open the Scan Configuration you want to modify for scanning to a SharePoint site, or create a 

new Scan Configuration.
Select an existing configuration in which you have already specified your SharePoint site 
information, and then click on the Copy button to create a new configuration using the settings of 
the current configuration. 

3. Click on the SharePoint tab and fill in the fields with the information for your SharePoint site.

• Protocol—Select which protocol you want to use to transfer the scan to the server.
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• SharePoint URL—Input the full URL path of the SharePoint site without the http(s):// designation 
and actual page. This path should include everything except the destination folder. 
For example, if the web browser URL displays http://sharepoint.site.com/IT/common/shared 
documents/default.aspx, then you would configure the SharePoint server path as follows:
• Select HTTP as the protocol
• The SharePoint URL would be sharepoint.site.com/IT/common 
• The Destination folder would be shared documents 

• User account—Input the user account name that has privileges to save files to the specified 
SharePoint site and Destination folder.

• Password—Input the password for the user account name you specified.
• Use Windows Integrated Authentication—Select this option to use the Windows current user’s 

login name and password to access the SharePoint site.
• Destination folder—This is the folder where the final scanned document(s) are transferred to 

when scanning is complete.
• Filename format—Select a file naming format, for the scanned document, from the list. Select 

“Use custom file naming” to use the file you set on the Options tab in the One Touch Properties 
window.
Count—This field will enable when the selected Filename format contains {seq}. Input the 
number you want the sequential count to start from.
Filename prefix—This field will enable when the selected Filename format contains {prefix}. 
Input the name or value you want as the prefix in the final file name.

Because the destination configuration is done through the scan configuration, you can set each 
configuration to scan to different SharePoint site, folder, filename format, using different user 
credentials, and so on. This is the same process used as when scanning to different folders using the 
Transfer to Storage destination, as described in detail starting on page 79.

Click on the Help button, in this configuration tab, to launch the SharePoint help file. The help file 
contains detailed information about the settings in this window and technical implementation notes.

SharePoint Link Log Viewer

The One Touch Link Log Viewer opens automatically when scanning is complete. Click on the menu 
arrow next to View logs for and select SharePoint Link from the list to display the transfer history for 
the SharePoint link only. 
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Double-click on any of the line items to open the selected log file in the Log File Detail View. If you 
open a failed transfer, the log file may contain the information you need to determine why the transfer 
failed. After you address the failure indicated in this log file, you can click the Retry button to resend 
the document to the server.

Click on the Properties button to open the Log Viewer from the SharePoint One Touch Link Properties 
window. There are no global configuration properties for the SharePoint destination application, all 
configuration is done using the Scan Configuration Properties window as described in the previous 
section.
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FTP Transfer

The FTP Transfer destination link allows scans to be sent directly to an FTP server from One Touch. 
Please contact your server administrator for the server information you need to configure this link. 
Alternatively, have your site administrator or IT professional configure this link for you. Setup and 
configuration of the FTP server and user accounts are outside the scope of this document.

Supported file types—All image and text file formats, except HTML, are available when scanning to 
an FTP server. Note that text file formats are only available if an OCR module or application is installed. 
Please refer to Text Formats on page 72 to see a list of text file formats that are available when OCR is 
installed.

Destination type—The FTP Transfer destination is classified as a “Storage Link”. To make it available 
in the destination list, you must select Storage and CD-R/W on the Options tab in the One Touch 
Properties window. 

All configuration of the FTP server is done using the FTP Settings tab in the Scan Configuration 
Properties window. 
1. Select FTP Transfer as the destination application.
2. Open the Scan Configuration you want to modify for scanning to an FTP server, or create a new 

Scan Configuration.
Select an existing configuration in which you have already specified your FTP server information, 
and then click on the Copy button to create a new configuration using the settings of the current 
configuration. 

3. Click on the FTP Settings tab and fill in the fields with the information for you FTP server.

• Protocol—Select which protocol you want to use to transfer the scan to the server.
• Host—Input the internet or intranet path of the server where you want to send the scanned 

documents. you do not need ftp:// at the beginning. For example, ftp.company.com
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• Port—Input which port to use with the selected protocol. Changing the selected protocol will reset 
this value to the appropriate default for the protocol.

• User account—Input the user account name that has privileges to save files to the specified host 
destination folder.

• Password—Input the password for the user account name you specified.
• Destination folder—Input the folder path, on the remote FTP server, where you want the 

scanned documents sent. This path would appear in your web browser after the host name. For 
example, marketing/shared documents/data sheets. 

Because the destination configuration is done through the scan configuration, you can set each 
configuration to scan to a different FTP server, destination folder, and so on. This is the same process 
used as when scanning to different folders using the Transfer to Storage destination, as described in 
detail starting on page 79.

FTP Link Log Viewer

The One Touch Link Log Viewer opens automatically when scanning is complete. Click on the menu 
arrow next to View logs for and select FTP Link Agent from the list to display the transfer history for 
the FTP link only. 

Double-click on any of the line items to open the selected log file in the Log File Detail View. If you 
open a failed transfer, the log file may contain the information you need to determine why the transfer 
failed. After you address the failure indicated in this log file, you can click the Retry button to resend 
the document to the server.
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Click on the Properties button to open the Log Viewer from the FTP One Touch Link Properties window. 
There are no global configuration properties for the FTP destination application, all configuration is 
done using the Scan Configuration Properties window as described in the previous section.
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SMTP 

The SMTP destination link allows scans to be sent directly to an email address, through an SMTP server, 
from One Touch. Please contact your server administrator for the server information you need to 
configure this link. Alternatively, have your site administrator or IT professional configure this link for 
you. Configuration of the SMTP server settings and user accounts is outside the scope of this 
document.

Supported file types—All image and text file formats, except HTML, are available when scanning to 
an SMTP server. Note that text file formats are only available if an OCR module or application is 
installed. Please refer to Text Formats on page 72 to see a list of text file formats that are available 
when OCR is installed.

Destination type—The SMTP destination is classified as a “Email Link”. To make it available in the 
destination list, you must select Email on the Options tab in the One Touch Properties window. 

All configuration of the SMTP server is done using the SMTP Settings tab in the Scan Configuration 
Properties window. 
1. Open the Scan Configuration you want to modify for scanning to an SMTP server, or create a new 

Scan Configuration.
Select an existing configuration in which you have already specified your SMTP server 
information, and then click on the Copy button to create a new configuration using the settings of 
the current configuration. 

2. Click on the SMTP Settings tab and fill in the fields with the information for you SMTP server.

• Protocol—Select which protocol you want to use to transfer the scan to the server.
• Host—Input the internet or intranet path of the server where you want to send the scanned 

documents. For example, smtp.company.com
• Port—Input which port to use with the selected protocol. Changing the selected protocol will reset 

this value to the appropriate default for the protocol.
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• User account—Input the user account name that has privileges to send email messages through 
the SMTP server. 

• Password—Input the password for the user account name you specified.
• Use Windows Integrated Authentication—Select this option to use the Windows current user’s 

login name and password to send the message through the SMTP server.
• Email to—Input a valid recipient email address to receive the scanned document. If it is not a 

valid address the transfer will fail.
• Email from—Input the email address you want to appear in the email message “from” field. 
• Limit (MB)—Input the maximum message size limit set on the SMTP server. This number should 

be lower than or match the SMTP server maximum. You cannot send messages that exceed the 
maximum message size of the SMTP server. 

Because the destination configuration is done through the scan configuration, you can set each 
configuration to scan to a different SMTP server, send messages to different email addresses, using 
different user credentials, and so on. This is the same process used as when scanning to different 
folders using the Transfer to Storage destination, as described in detail starting on page 79.

Click on the Help button, in this configuration tab, to launch the SMTP help file. The help file contains 
detailed information about the settings in this window and technical implementation notes.

SMTP Link Log Viewer

The One Touch Link Log Viewer opens automatically when scanning is complete. Click on the menu 
arrow next to View logs for and select SMTP Link Agent from the list to display the transfer history for 
the SMTP link only. 

Double-click on any of the line items to open the selected log file in the Log File Detail View. If you 
open a failed transfer, the log file may contain the information you need to determine why the transfer 
failed. After you address the failure indicated in this log file, you can click the Retry button to resend 
the document to the server.
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Click on the Properties button to open the Log Viewer from the SMTP One Touch Link Properties 
window. There are no global configuration properties for the SMTP destination application, all 
configuration is done using the Scan Configuration Properties window as described in the previous 
section.
Xerox DocuMate 4790
User’s Guide

97



Email Applications

Scanning to an email application, such as Outlook or Windows Mail, attaches the scanned image to a 
blank email message. You then fill in the recipient email address(es) and send the message. You need 
to have configured an email application before you can scan to it using One Touch. If you do not have 
your email application set up prior to scanning, the default Windows email application will open and 
ask you to configure your user information. Please contact your IT department, server administrator, or 
other group that provided you the email information for setup instructions. Configuring an email 
application and user account is outside the scope of this document.

Supported file types—All image and text file formats, except HTML, are available when scanning to 
an email application. Note that text file formats are only available if an OCR module or application is 
installed. Please refer to Text Formats on page 72 to see a list of text file formats that are available 
when OCR is installed.

Destination types—The email destination is classified as an “Email Link”. To make it available in the 
destination list, you must select Email on the Options tab in the One Touch Properties window. 

The email application in the One Touch destination list is the default email program selected in the 
Internet Options of Internet Explorer. Click on the email application that is in the list, then click on the 
Properties button to launch the Email One Touch Link Properties window to change the email 
application. 
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Email Properties

Use the Email Link Properties window to select a folder for storing a permanent copy of the scanned 
image, setting the color document options, and changing the email application that is in the 
One Touch destination list. 

• Folder for storing attachments—Click the Browse button to change the location using the 
Windows file browser, or type a location directly in the field.

• Internet options—If you need to change your email client, or any other internet options, click the 
Internet Options button.
The Windows Internet Options Control Panel opens. Click the Programs tab and choose a new 
email client from the program list. These are the standard Windows Internet Explorer options. 
Please see your Windows documentation for more information about the Internet Explorer 
options.

Color document handling—Click in the Color document handling settings boxes for the options you 
want.
• Convert Bitmaps using Screen Resolution—Use this option to ensure that an image will fit on 

the computer’s screen. 
• Convert Bitmaps to JPEG—JPEG files can be compressed to produce smaller files sizes and, 

therefore, shorter transmission times when you email the file or upload it to the internet.

If you changed the email application Internet Explorer, and it does not immediately appear in the 
Select destination list, click the Refresh button to update the destination list in One Touch. 
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Text Editors

Scanning to a text editing application, such as Microsoft’s Notepad or WordPad, automatically 
converts the text in the scanned image into editable text using Optical Character Recognition (OCR). 

Supported file types—The text file formats and destination applications are only available if an OCR 
module or application is installed. Please refer to Text Formats on page 72 to see a list of text file 
formats that are available when OCR is installed. Additionally, the available file formats are application 
specific, for example Microsoft’s WordPad can open *.txt and *.rtf files, so only those two file types will 
be available when scanning to WordPad. 

Note that when there is no OCR module or application installed, the format panel will not contain a 
text icon and there will be no text editor applications in the Select destination list. 

Destination type—This destination type is classified as a “Text Based Link”. To make it available in the 
destination list, you must select Text editing applications on the Options tab in the One Touch 
Properties window. If the text editing application you are using does not appear in the Select 
destination list, you can add the application using the Text Documents One Touch Link Properties 
window. 
1. In the One Touch Properties window select one of the default text editors such as WordPad.

2. Click on the Properties button to open the Text Document One Touch Link Properties window. 
From this window you can select what One Touch should do when text is not detected or 
recognition fails, and add other applications to One Touch.
Note that if you recently installed an application, click the Refresh button to see if One Touch will 
automatically configure the link before you try adding it manually.
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Text Documents Properties

These properties apply to Microsoft Word, Microsoft Excel®, and any other text editing applications 
indicated by their icons in the list.

• Add application—Click this button to open the Add Text Based Link dialogue so you can add 
other text editing applications to One Touch. 

• Delete application—Select an application in the list then click this button to remove the 
application from the One Touch destination list. You can only delete an application that you have 
added, the destinations that are linked when One Touch is installed cannot be deleted.

Click in the OCR settings boxes for the options you want. The options will apply to all the applications in 
the group. 
• Always send a file, even when no text was found—The scanned file is sent to the application 

even if the image does not appear to contain text. This could occur if you scanned a photograph 
with a scanner button set for text applications.

• Show message if text recognition failed—A message will open on the screen if the OCR reader 
does not detect text in the image.
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Adding Text Editor Applications to One Touch

1. To add another application to the list, click the Add Application button. The Add Text Based Link 
dialog box opens.

2. Click Browse to find the application you want to add to the list.
When you select the application using the Browse button, steps 1 and 2 on the dialog box are 
automatically filled in, and the application icon appears in step 3.

3. Select the icon in Step 3 of the dialog box. That is the icon that will appear in the One Touch 
Destination List.
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4. In step 4 of the dialog box, select the file formats that the application will accept. 
HTML Formatted file—Select this option when you want to scan to your web browser for posting 
HTML pages to a website. Even though word processing applications, such as Notepad and Word 
can open *.htm files, you cannot scan as *.htm to word processing text editors. Scanning as HTML 
creates a directory with the *.htm file and linked images for website use. Word processing 
applications cannot accept a directory structure for image and text transfer.
Rich Text Format—Select this option if your application can open *.rtf files, which are plain text 
documents that contain formatting. Microsoft’s WordPad application is a compatible application 
for the *.rtf file formation.
Standard ASCII text file—Select this option if you want to have plain text, without formatting, 
sent to your text editing application. Most text editing applications will accept plain text (*.txt) 
files.
Adobe PDF format—Select this option if you are adding a PDF viewing or editing application to 
the list. This PDF format is an image format only, it will not recognize the document using OCR, 
and you will not be able to search or edit the text in the final file. The application you are adding 
must be able to open *.pdf files.
Adobe searchable PDF—This is the PDF image format with a hidden searchable text layer. You 
will not be able to edit the text the file. The application you are adding must be able to open *.pdf 
files.
The options you select at step 4 determine the page format icons in the One Touch Properties 
window for that group of applications. Refer to the documentation you received with the 
application to see which text formats the application accepts. 

5. When you are done making changes in this window, click the Add button to accept the changes 
and close the window. 

6. Click OK on the Link Properties window.
7. Click Refresh on the One Touch Properties window and the new application should now be 

available.
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Creating an HTML Web Page from Your Scanned Documents

1. Open the One Touch Properties window. 
2. Select your web browser as the Destination Application and Choose HTML as the Format.

3. Choose a Scan Configuration that has the settings for how you want any images, on the pages 
you are scanning, to be displayed. For example, choose a color or grayscale scan configuration if 
your documents contain images that you want posted to your website with the HTML text. 

4. Click OK.
5. Start scanning using the button you selected for scanning with the HTML format.

When scanning is finished, the document is first converted to editable text using the OCR process, 
then converted into an HTML format. Any images detected by the OCR engine are isolated and 
linked as *.gif files.

6. Microsoft Internet Explorer, or other web browser you scanned to, then opens showing your 
converted page. The application’s URL field shows the location where One Touch saved the HTML 
files for you to locate and post to your website.

Choose HTML
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Still Image Client 

If you want to specify an application to use for scanning at the start of the process, you can use event 
forwarding. 

Supported file formats—You cannot select a file format when scanning to the Still Image Client as 
the destination application is not selected until after you start scanning.

Destination type—The Still Image Client destination is classified as an “Event Forward Link”. To make 
it available in the destination list, you must select STI event forwarding on the Options tab in the 
One Touch Properties Window.

Please note that if you are have turned on the option to scan to multiple destinations, the Still Image 
Client destination cannot be selected. Please click on the Options tab and deselect Enable scanning to 
multiple destinations to proceed with scanning to this destination.

1. Open the One Touch Properties window, and select Still Image Client as the Destination 
Application.

2. Choose a Scan Configuration and click OK.
3. Start scanning using the button you selected for event forwarding.
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4. A dialog box opens for you to select the application to use for scanning. Select the application you 
want in the box and click OK.

Now the application you selected opens and you can continue scanning using that application’s 
interface. 

Technical Note

If the scanner scans and sends an image to an application without prompting you to choose an 
application to run, the control panel options for your scanner’s events are automatically set to run a 
specific program when an event is initiated. Follow these steps to change the events setting for your 
scanner.
1. Open the Windows Control Panel.
2. Open the Scanners and Cameras group.

When the Control Panel is in Classic View, the Scanners and Cameras group will be in the list.
When the Control Panel is in Category View (Windows XP), or Home View (Windows Vista and 7), 
the Scanners and Cameras group will be located under either of the following main groups:
• Windows XP—Printers and Other Hardware
• Windows Vista and 7—Hardware and Sound

3. Open the scanner properties window.
• Windows XP—Click on the scanner icon and then click on the View device properties link on 

the left side of the window.
• Windows Vista and 7—Click on the scanner icon and then click on the Properties button.

4. Click on the Events tab.
5. Select the option Prompt for which program to run to be prompted when scanning to Still Image 

Client. Alternatively, select Start this program then choose an application from the list to have 
that application start each time you scan to Still Image Client. 

6. Click on OK when you are done making changes to this window.
7. Now when you scan with Event Forwarding you will either be prompted to choose an application, 

or the default application you selected will open.
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Image Editors

Image editors include Microsoft Paint and other drawing and graphics applications. 

Supported file formats—The available file formats are based on the selected destination application. 
For example, you can scan to Microsoft’s Paint application as a BMP, GIF, PNG, or JPG, but not as TIFF 
or JP2 as Paint cannot open those two file types. Please refer to Image Formats on page 70 for more 
information on which image formats One Touch supports.

Destination type—This destination type is classified as a “Simple Image Link”. To make it available in 
the destination list, you must select Image editors (i.e. Paint) on the Options tab in the One Touch 
Properties window. If the image editing application you are using does not appear in the Select 
destination list, you can add the application using the Image Documents One Touch Link Properties 
window. 
1. In the One Touch Properties window select one of the default image editors such as Microsoft 

Paint.

2. Click on the Properties button to open the Image Documents One Touch Link Properties window.
From this window you can add an application and set additional document handling options.
Note that if you recently installed an application, click the Refresh button to see if One Touch will 
automatically configure the link before you try adding it manually.
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Image Documents Properties

These properties apply to Microsoft Paint and other image processing applications.

• Add application—Click this button to open the Add Simple Image Link dialogue so you can add 
other image editing applications to One Touch. 

• Delete application—Select an application in the list then click this button to remove the 
application from the One Touch destination list. You can only delete an application that you have 
added, the destinations that are linked when One Touch is installed cannot be deleted.

Color document handling—Click in the Color document handling settings boxes for the options you 
want. These options will apply to all the applications in the group.
• Convert Bitmaps using Screen Resolution—Use this option to ensure that an image will fit on 

the computer’s screen. When a computer screen is set to a lower resolution, bitmap images with a 
higher resolution may be too big to fit on the screen. Converting the bitmap image to match the 
screen resolution ensures that the image fits on the screen.

• Convert Bitmaps to JPEG—JPEG files can be compressed to produce smaller file sizes and, 
therefore, shorter transmission times. Use this option to provide that compression capability to 
image files.
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Adding Image Editor Applications to One Touch

1. To add another application to the list, click the Add Application button. The Add Simple Image 
Link dialog box opens.

2. Click Browse to find the application you want to add to the list.
When you select the application using the Browse button, steps 1 and 2 on the dialog box are 
automatically filled in, and the application icon appears in step 3.

3. Select the icon in Step 3 of the dialog box. That is the icon that will appear in the One Touch 
Destination List.

4. In step 4 of the dialog box, select the file formats that the application will accept. 
Windows Bitmap File—Select this option if you want to scan to your image application as a BMP 
file. This format creates the largest file size as the final scanned image has not been compressed.
Tagged Information File—Select this option if your application supports TIF image files. The TIF 
file format supports multiple pages in a single file.
JPEG Compressed File—This is a compressed image format that is often used when sharing 
photographs and scanned images electronically as the file size is smaller than a BMP.
Compugraphics File—Select this option if your application supports GIF images. This file format 
is often used for icons and small images on a web page.
The options you select at step 4 determine the page format icons in the One Touch Properties 
window for that group of applications. Refer to the documentation you received with the 
application to see which text formats the application accepts. 

5. When you are done making changes in this window, click the Add button to accept the changes 
and close the window. 

6. Click OK on the Link Properties window.
7. Click Refresh on the One Touch Properties window and the new application should now be 

available.
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PDF Applications

PDF destinations are applications that can open and/or edit the Adobe PDF file format. 

Supported file types—Applications in the PDF destination group support the *.pdf file format. When 
the OmniPage module or software is installed, One Touch includes an option to scan as sPDF or nPDF. 
Selecting either of these two formats still creates a *.pdf file, but the “s” and “n” letters indicate that 
OCR will process the image before sending the file to the PDF application. 
• sPDF—This format creates a *.pdf file that contains the original image of the scanned page, with 

a hidden text layer that allows you to search for text in the file.
• nPDF—This format creates a *.pdf file that can be edited in a PDF application. Any pictures in the 

scanned image are isolated from the text, the text on the page is recognized and turned into 
editable text, and the pictures are placed back into the document in the same flow as the original 
document. 

Destination type—This destination type is classified as “PDF Link”. To make it available in the 
destination list, you must select PDF applications on the Options tab in the One Touch Properties 
window.

If the PDF application you are using does not appear in the Select destination list, you can add the 
application using the Text Documents One Touch Link Properties window. 
1. Click on the Options tab in the One Touch Properties window.
2. Make sure PDF applications and Text editing applications are selected then click back on the 

button tab.
Please note that any PDF application you add manually to One Touch will be classified as a “Text 
Based Link.” These applications will only show in the destination list when Text editing 
applications are enabled.
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3. Click on one of the default text editors such as WordPad.

4. Click on the Properties button.
5. To add another application to the list, click the Add Application button. The Add Text Based Link 

dialog box opens.

6. Click Browse to find the application you want to add to the list.
When you select the application using the Browse button, steps 1 and 2 on the dialog box are 
automatically filled in, and the application icon appears in step 3.

7. Select the icon in Step 3 of the dialog box. That is the icon that will appear in the One Touch 
Destination List.
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8. In step 4 of the dialog box, select Adobe PDF format and Adobe searchable PDF. 
Adobe PDF format—Select this option if you are adding a PDF viewing or editing application to 
the list. This PDF format is an image format only, it will not recognize the document using OCR, 
and you will not be able to search or edit the text in the final file. The application you are adding 
must be able to open *.pdf files.
Adobe searchable PDF—This is the PDF image format with a hidden searchable text layer. You 
will not be able to edit the text the file. The application you are adding must be able to open *.pdf 
files.
The options you select at step 4 determine the page format icons in the One Touch Properties 
window for that group of applications. Refer to the documentation you received with the 
application to see which text formats the application accepts. 

9. When you are done making changes in this window, click the Add button to accept the changes 
and close the window. 

10. Click OK on the Link Properties window.
11. Click Refresh on the One Touch Properties window and the new application should now be 

available.
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Send to Application

The Send to Application link allows you to select any application on your computer as the scan 
destination. 

Supported file types—All file formats in One Touch are available when scanning to this destination. 
After you configure the link, as described below, make sure you select a file format that the application 
can open. Please refer to Text Formats on page 72 to see a list of text file formats that are available 
when OCR is installed. 

Destination type—This destination type is classified as “Document Management Link”. To make it 
available in the destination list, you must select Document Management on the Options tab in the 
One Touch Properties window.

You must configure this destination before attempting to scan to it the first time. If you scan without 
configuring the link first, the One Touch log viewer will open and show that sending the image to the 
Send to Application link failed. 

• Click the Properties button to open the One Touch Link Properties for the Send to Application link. 
From this window, you can configure the default application for this link.
After configuring the link properties, all of the default scan configurations will immediately update 
to send to the application you specify in this window. When you create new configurations, the 
default settings will also match what you have selected here. If you modify the options in an 
individual configuration, changing the options in this Link Properties window will no longer update 
to the configurations you modified.

• Click the New, Copy, or Edit button to open the Scan Configuration Properties window. Click on 
the Send to Application tab and use this window to set a configuration to scan to a different 
application than the one selected in the Link Properties window.
Changing the options in this window only affects the configuration you are creating or modifying. 
All other configurations will retain their settings for this destination. 
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To configure a destination application for the Send to Application link:

1. Click Browse to open the Windows file browser and navigate to the location of the application’s 
executable (*.exe) file. 
In most cases, the application’s directory is located in the programs directory on the C:\ drive. 
Because you can select any executable file, make sure you select an application that can receive 
image or text files.

2. Select the application’s *.exe file then click on Open. 
The application’s *.exe file path will now show in the Application path field.

3. Click on OK to close the window.
For basic scanning, you do not need to adjust any of the other settings in this window. The default 
settings will work with most applications. The advanced settings are described below.

4. Select a file format and scan configuration in the One Touch Properties window.
If you select a text file format, the scanned image is converted into editable text before being sent 
to your selected application.

5. Click on OK to close One Touch.
6. Put the document(s) in the scanner and start scanning with the button you set to use the Send to 

Application destination.
7. The scanner starts scanning and, when finished, sends the scanned file to the application you 

selected.

Technical note
• After configuring this link, you may need to click Refresh in the One Touch Properties window to 

show the correct application icon in the Select destination list.

Send to Application One Touch 
Link Properties window

Send to Application Scan 
Configuration Properties window
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Configure advanced features—Select this option to change the default settings for this link. Only 
advanced users and application developers should modify these settings.

• Launch application for every image—When this option is selected, the application will open one 
time for each image scanned. You should deselect this option only if the application you are 
scanning to will accept multiple page files. 
For example, Microsoft’s Paint application can only accept 1 image at a time, so when scanning 
multiple images, Paint would open each time an image is transferred when this option is selected. 
On the other hand, Microsoft’s WordPad will open a multiple page file, so when scanning multiple 
images WordPad would need to launch only one time when this option is not selected. If you scan 
to WordPad and this option is still selected, then WordPad will open 1 time for each image 
transferred.

• Command line arguments—Input the options that are to be used when the application is 
launched. These values are application specific and you should only input values that were 
provided to you by the application developer. Command line arguments are not required for you 
to use this link, the field can be left blank and you can change the other settings in this section as 
needed.

• Append scan filename(s) to arguments—This option adds the name of every image file to the 
end of the list of arguments specified above. This is the default selection as most applications do 
not require, and may not work with, a job file containing the image names.

• Append job file to arguments—This option adds the name of a job file to the end of the list of 
arguments specified above. This unique file is created at scan time and contains a list of every 
image in the scan job. Only select this option if you are sure that the application you are scanning 
to can use the job file to accept image transfer.

Send to Application One Touch 
Link Properties window

Send to Application Scan 
Configuration Properties window
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Scanning to Multiple Destinations

Scanning to multiple destinations works the same as when scanning to a single destination, One Touch 
simply distributes the final scan to several destinations. This option is enabled separately for each 
One Touch button. 
1. Open the One Touch Properties window and click on the Options tab.

2. Select Enable scanning to multiple destinations, then click back on the configuration tab.
3. Click each destination where you want to send the scanned image in the Selected destinations 

(#) list. Click again to deselect a destination.
As you click on each destination, the Selected destinations number will count so you know how 
many applications are selected to receive the image.
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4. If any of the destinations you select have global configuration properties, the Properties button at 
the bottom of the Selected destinations list will be enabled for you to configure the destination 
options. Click on the Properties button to open the One Touch Link Properties window to configure 
the destinations.

Each destination that has global properties will be represented by its configuration tab in the 
One Touch Link Properties window. Please refer to the destination instructions, as described in the 
previous section(s), for configuring destination specific options.
Click on OK when you are done making changes in this window.

5. Select the file format you want for the scanned image in the Select format panel.
You can only scan as one file format at a time, so all selected destinations must have a common 
file type. As you select destinations, destinations that do not have a file type in common with the 
one you selected, will automatically disable. 
For example, if you scan to a printer and to email, only the BMP file format will be available as 
printers can only receive an uncompressed image format. All other image formats and all text 
formats will be disabled until you deselect the printer.
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6. Select the scan configuration you want to use for scanning in the Select configuration list.
Click on the Edit button to open the Scan Configuration Properties window to configure any 
destination specific scanning options. 

Each destination that has per-scan configuration properties will be represented by its 
configuration tab in the One Touch Scan Configuration Properties window. Please refer to the 
destination instructions, as described in the previous section(s), for configuring destination 
specific options.
Click on OK when you are done making changes in this window.

7. Click on OK on the One Touch Properties window.
8. Load the document(s) in the scanner and start scanning with the button you set to scan to 

multiple destinations. 

The scanner starts scanning and when finished, the image is sent to each destination you selected in 
the One Touch Properties window.

Technical Note
• The Still Image Client destination cannot be used with multiple destination scanning. This 

destination will be disabled when the Enable scanning to multiple destinations is selected.
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Scanning with Job Separation

Use job separation to have One Touch create a new file each time a separator is detected when 
scanning a multiple page batch. For example, if you want to scan financial statements from several 
different banks, you can place a stack of statements in the scanner and One Touch will separate each 
statement into a different file based on your selected job separator.
1. Open the One Touch Properties window.
2. Select the Destination Application, File Format, and Scan Configuration applicable to your 

scanning batch.
Make sure the option Create single image files is not selected. If this option is selected, the job 
separation features on the Options tab will be disabled.

3. Click on the Options tab in the One Touch Properties window.
4. Click on the down arrow next to the Select Button list to select the button you want to modify.

Note that the options in this window are specific to each One Touch button. 
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5. Click on the option Use job separator when scanning multiple pages.

6. Select one of the two job separation options:
When a blank page is detected—a new file will be created after a blank page is fed through the 
scanner. The blank page is discarded from the scanned image and the new file starts with the next 
page in the document stack. Place a blank page, in the document you are scanning, at each place 
where you want a new file created when scanning is complete.
When you are scanning in Duplex mode, both sides of the page must be blank for this job 
separation option to work.
• Sensitivity—you can adjust the sensitivity level of the blank page detection. For instance, 

depending on the paper weight, color mode, or image processing options selected, you might 
get varying results. Changing the sensitivity level allows you to fine-tune the accuracy of the 
blank page detection.

When the number of images reaches—input the maximum number of images you want in the 
scanned file. The scanner will create a new file each time that number is reached. 
When you are scanning in Duplex mode, the number of images captured is double the number of 
pages in the scanner. For example, if you are scanning 12 double-sided pages it is counted as 24 
images. If you want the stack split in half, the number of images reached would be 12.

7. When you are done making changes, click on OK to save the changes and close the window.
8. Place your documents in the scanner and start scanning.

When scanning is finished, each file will be sent to the destination location or application you have 
selected on the button tab.

Technical Note
• When Instant delivery is also selected on the Options tab, each file will be sent as it is created. 
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The options on the Page Settings tab, in the Scan Configuration Properties window will affect the job 
separation options as described below:

Skip blank originals
• The Sensitivity you set for this feature is the one that is used when scanning. The sensitivity level 

you set in the Options tab will be ignored.
• When you are scanning in Simplex mode and the selected job separator is When a blank page is 

detected, the job separation occurs first and a new file will be created each time a blank page is 
detected. If you want a single file created with the blank page discarded, deselect the job 
separation feature on the Options tab. 
Note that when scanning Duplex, both sides of the page must be blank for the job separation to 
occur. If both sides of a scanned page is blank, the job separation occurs first and a new file will be 
created each time a blank page is detected. If you want a single file created with the blank page 
discarded, deselect the job separation feature on the Options tab or remove the blank page from 
your scanning batch.

• If you select When the number of images reaches, and input a number in the control box, any 
blank pages will be discarded first, and then the number of images scanned will be counted. For 
example, if you scan 12 pages and 3 are blank, the total number of images counted for the job 
separation will be 9 not 12.
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Scanning with Optical Character Recognition 
(OCR)

Optical Character Recognition (OCR) converts text and numbers on a scanned page into editable text 
and numbers. You can then work with the text and numbers to edit, spell check, change font or type 
size, sort, calculate, and so forth.

The One Touch OmniPage Module or the OmniPage Pro software must be installed on your computer 
in order to use the OCR options with the One Touch software and your Xerox scanner. The One Touch 
OmniPage Module was automatically installed when you installed your driver from the installation disc.

To scan with OCR:
1. Open the One Touch Properties window.
2. Select a text editing program in the Select Destination list, then select a text file format in the 

Select Format panel.
For example, if you want to edit your document in Microsoft’s WordPad, select that application 
then choose a file format such as TEXT or RTF.

3. Click on OK to save the changes and close the One Touch Properties window.

Note: Xerox recommends that all OCR processing use the original factory settings for OCR scanning 
that came with your scanner. When scanning with other settings, use at least 300 dpi for the 
resolution. If the original documents are of poor quality or have a small type font, 400 dpi can be 
used as the maximum resolution.

Note: Some of the illustrations in this section may not look exactly as they appear on your computer’s 
screen. The differences are minor and do not affect the steps to use the new features. 
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4. Press or click the One Touch button you set to scan with OCR.
Your scanned pages appear in the Destination Application with the text ready for editing and 
other text processing.

Text Formats

You select the text format option by clicking on the text icon on the One Touch Properties window. 

Selecting the text format option also selects OCR processing as an automatic step for scanning. 
Therefore, when you scan a document with the text format selected, the text portions of the document 
are automatically converted to editable text.

As you select Destination Applications that are text applications, the text format icon changes to 
match the file type of the application. In some cases, the Destination Application supports several file 
types, and you can right-click on the icon to choose the particular file type for that application.

The specific file format is the file name extension on the text format icon.

To select a file type for the text format:

1. Select the Destination Application.

This is the text format icon. 
This example of the text 
format icon is sPDF.

The specific text format; this example is 
for Rich Text Format (.rtf).
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2. Right-click on the text format icon. 

3. Choose the file type that you want for the text format.
Your selection of a file type pertains only to the Destination Application currently selected on the 
One Touch Properties window. Other Destination Applications that have a text option selected as 
the Page Format are not affected.

Simple Text—The .txt file format. Text with no formatting; used by the standard Microsoft 
Notepad application.

Rich Text Format—The .rtf file format. Text that retains formatting when converted. 
Available with Microsoft WordPad and Word.

Word Document—The .doc file format used by Microsoft Word.

Comma Delimited—The .csv file format; used for database or spreadsheet data with fields, 
when the document is converted into editable text the fields are maintained.

Excel Spreadsheet—The .xls file format used by Microsoft Excel.

HTML Document—The .htm file format used to create web pages.

Searchable PDF—The .pdf file format used by Adobe Acrobat. This format converts scanned 
text into PDF with an invisible text layer for searching.

Example menu for the TEXT format when the 
Destination Application is a Storage location.

Example menu for the TEXT format when the 
Destination Application is Microsoft Word.
Xerox DocuMate 4790
User’s Guide

124



Additional options are available on the menu for the sPDF and nPDF text formats. The three image 
quality settings are: 

Minimize Size—Smallest file size, lowest image quality.
Normal—Medium file size, some loss of image quality.
Maximize Quality—Largest file size, no loss of image quality.

The Use MRC option is a special processing procedure for documents scanned with the PDF format.
Use MRC—MRC stands for Mixed Raster Content. MRC is an advanced technique for optimizing 
the image quality of scanned documents. Without MRC, the scanned image is produced using a 
single process to capture and display the image on the computer screen, even if the document 
contains both text and graphics. With MRC, the image is produced using separate processes for 
text, graphics, and other elements on the document page. The result is clearer graphics and 
sharper text characters. Scans with Use MRC selected may take slightly longer to complete the 
processing. Select Use MRC for documents with harder-to-read text or lower-quality graphics to 
get the best possible scan output image. The Use MRC option is available for sPDF and PDF.

Normal PDF—The .pdf file format used by Adobe Acrobat. This format converts scanned 
text into a PDF with the text ready for editing in a PDF editing program.

Note: Documents scanned with nPDF and sPDF automatically include OCR processing. If the 
processing does not recognize a large number of the text characters in the document, change the 
image quality setting and re-scan the document. For example, change from Minimize Size to Normal 
to see if the text recognition improves.
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Selecting One Touch OmniPage OCR Options

The software you installed for your scanner includes a set of advanced OCR options integrated with 
One Touch.

To select OCR options available from One Touch:
1. Open the One Touch Properties window.
2. Select a Destination Application that has one of the text format file types as the page format, 

such as Microsoft Word or WordPad.
3. Right-click on the page format icon to see the menu.
4. Choose OCR Options from the menu.

The OCR Properties window opens with the OCR tab selected.

Note: The OCR options apply globally to all the One Touch Destination Applications that perform 
OCR. For example, if you select the OCR options for Adobe Acrobat, they also apply to WordPad.
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The OCR Tab

The options shown on the OCR tab window are for spellchecking scanned text, replacing missing or 
unrecognized characters, and setting the speed and quality levels of the OCR processing.

1. Choose the options you want from the OCR window.
Languages in Document—Click on the language(s) in list that correspond to the languages in the 
documents to be scanned. You can click on multiple languages. These are the languages that will 
be recognized during the OCR process. For faster and more reliable language recognition, select 
only the languages in the documents. 
The languages are in alphabetical order. Type the first letter of a language’s name to jump to its 
section in the list.
Use languages and dictionaries to improve accuracy—Select this option to automatically check 
the validity of the recognized words. An OCR engine looks at each letter or symbol on the page 
individually, then “guesses” what the letter or symbol is based on the shape. Therefore, the OCR 
engine may have more than one guess for a particular letter or symbol, a “best guess”, a “second-
best guess”, and so on. This option tells the OCR engine to look through the dictionary to validate 
its best guess for the letters in that word; if its best guess is not in the dictionary, it checks for the 
second-best guess, and so on. 
For example, if the word “house” appears in the original document but the OCR engine is 75% 
sure that the “o” is actually an “a”, the finished document would have the word “hause”. Turning 
this option on tells the OCR engine to look at the other letters in the word, check to see which 
version of the word is in the dictionary, and output the correct word “house” in the final document. 
The OCR engine does not automatically correct misspelled words that were present in the original 
document.
When dictionaries are selected, the terms in those dictionaries are used to check the spelling. If 
this is option is not selected, User Dictionaries and Professional Dictionaries cannot be selected.
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User Dictionary—A user dictionary is your personal dictionary with words that you want the OCR 
engine to reference for better accuracy when converting the document into editable text. For 
example, if you scan documents with highly technical terms or acronyms not found in typical 
dictionaries, you can add them to your personal dictionary. You can also add names that you 
expect to be in the documents too. This way, as the OCR process recognizes each letter or symbol, 
there is a higher chance that the technical term or name will be correctly spelled in the final 
document. You can create multiple user dictionaries. See the section Creating Your Own 
Dictionaries on page 128.
Click the menu arrow and select a user dictionary from the list.
If you select [none] as the user dictionary, the text will be validated using the terms in the 
dictionaries for the selected languages, as well as any professional dictionaries if they are selected.
The label [current] is next to the currently-select user dictionary.
Professional Dictionaries—These are legal and medical dictionaries containing highly specialized 
words and phrases. The options are: Dutch Legal, Dutch Medical, English Financial, English Legal, 
English Medical, French Legal, French Medical, German Legal, and German Medical. Select the 
appropriate dictionary for the OCR engine to use to validate the scanned text.
Reject Character—This is the character that the OCR process inserts for an unrecognizable text 
character. For example, if the OCR process cannot recognize the J in REJECT, and ~ is the reject 
character, the word would appear as RE~ECT in your document. The ~ is the default reject 
character.
Type the character you want to use in the Reject Character box. Try to choose a character that will 
not appear in your documents.
Missing Character—This is the character that the OCR process inserts for a missing text character. 
A missing text character is one that the OCR process recognizes, but cannot represent because 
that character is not available for the selected language. For example, if the document contains 
the text symbol “Ç” but the OCR process cannot represent that character, then every place “Ç” 
appears, the OCR process substitutes the missing character symbol. The caret (^) is the default 
symbol for the missing character.
Type the character you want to use in the Missing Character box. Try to choose a character that 
will not appear in your documents.
Recognition Quality—Drag the slider to the left or right to set the degree of accuracy for the OCR 
process. The higher the accuracy, the longer the OCR process requires to complete. For clean, 
highly-legible documents, you can set the recognition quality to a lower level to produce results 
more quickly. 

2. Click OK or Apply.
These options will now apply to the OCR processing when you select any text format as the page 
format.

Creating Your Own Dictionaries

You can create multiple dictionaries for your personal use. For example, you might have different 
dictionaries for separate work projects, especially if each project uses different acronyms and 
terminology.
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To create a personal dictionary:

1. Open any word processing program, such as Microsoft Word, WordPad, or Notepad.
2. Create a new document in the word processing program. 
3. Type each word you want in your new dictionary, followed by a carriage return. Make sure to spell 

the words correctly as they will be used for spellchecking.
Here is an example of what the text file might look like:
Xerox
One Touch
OmniPage
wysiwyg
jpeg
bmp
sPDF
nPDF
Note: The file does not have to include every word you want in the dictionary. You will be able to 
edit the list later. In fact, the file does not have to contain any text at all, and you could add the 
words using the editing options. However, if the list of words is long, it’s usually faster to type them 
in the word processing program. Note also that the words do not need to be alphabetized.

4. Save the document in the .txt format and give the file the name that you want for the dictionary. 
For example, give it the name USERDIC1.

5. Now open the OCR Options window. 
6. On the OCR Options window, click the button next to the menu arrow.
7. The User Dictionary Files window opens and shows the available dictionaries.

MyDictionary is an example of a user dictionary.
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8. Click Add New. 
The Add New User Dictionary window opens. 

9. Click the drop-down arrow for Files of type and choose Text Files (.txt).
10. Select the file you just created for your user dictionary and click Open.

In the example above, the file is named USERDIC1.
11. The text file now appears on the list of user dictionaries that you can use for spellchecking.

12. Select a dictionary and click Set As Current to set it as the current dictionary for spellchecking. 
The label [current] is added to the name.
If you don’t want to use any user dictionaries for spellchecking, click [none] at the top of the list.
To remove a dictionary from the list, select it and click Remove. This only removes the dictionary 
from the list. It does not affect the original text file you created with the list of words.

Editing User Dictionaries

Once a dictionary has been added to the list of user dictionaries, its list of words can be edited.
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To edit a user dictionary:

1. On the Add New window, select the dictionary to edit and click Edit.
The Edit User Dictionary window opens. It lists the words currently in the dictionary. The following 
example shows the words OmniPage and One Touch are in the user dictionary named 
MyDictionary.

2. To add a new word to the list, type it in the box for User Word and click Add. If the word includes 
any spaces before or after it, those spaces are removed and the word is added to the list.
To delete a word from the list, select it and click Delete.
If a word in the list is misspelled, delete it, then re-type the word correctly in the User Word box 
and click Add.

3. To import a list of words from another text file, click Import.
The Import Contents of User Dictionary window opens. 

4. Select the file that has the words you want to add to your user dictionary.
Importing will add the entire list of words in a file to the user dictionary.

5. Click Import. The file’s words will be added to your user dictionary list.
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6. To export a user dictionary so it can be used by another program, select the dictionary on the User 
Dictionary Files list and click Export. 

The Export User Dictionary window opens.

7. Select the dictionary file to export and click Save.
The file is exported as a formatted dictionary with the .ud filename extension so it can be opened 
by other programs.

The Format Tab

The options on the Format tab window are for setting the input and output formats for the scanned 
documents.
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1. Click the Format tab and choose the options you want for both the input and output formats.

Input Format Options
• Automatic—Choose this option to let the OCR process determine the format of the pages. 

Typically you select this option when the document has different or unknown types of 
layouts, pages with multiple columns and a table, or pages containing more than one table. 
The OCR process will then determine if text is in columns, an item is a graphic or text, and 
tables are present.

• Single Column no Table—Choose this option if the document contains only one column of 
text and no tables. Business letters are normally in this form. You can also use this option for 
documents with words or numbers in columns if you do not want them placed in a table or 
decolumnized or treated as separate columns.

• Multiple Columns, no Table—Choose this option if some document pages contain text in 
columns and you want it kept in separate columns, similar to the original layout. If table-like 
data is encountered, it is placed in columns, not in a gridded table. 

• Single Column with Table—Choose this option if your document contains only one column 
of text and a table. The table will be placed in a grid in the Destination Application you have 
selected. You can later specify whether to export it in a grid or as tab-separated text columns.

• Spreadsheet—Choose this option if the entire document consists of a table that you want to 
export to a spreadsheet program, or have treated as a table. No flowing text or graphics will 
be detected.

Output Format Options
• Automatic—The document will be formatted as close to its original as possible. The 

One Touch software will adjust its settings to the most appropriate for the document being 
scanned in order to match your selected output format. The output quality will be maximized 
and the processing time minimized.

• No Formatting (NF)—The document will be plain text, one column, left-aligned in a single 
font and font size. You can then export the plain text to nearly all file types and target 
applications.
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• Retain Fonts and Paragraphs (RFP)—This output format retains the font and paragraph 
styling, including graphics and tables without columnized text, but does not retain layout 
formatting. If the document is being scanned as an Excel spreadsheet, each detected table or 
spreadsheet becomes a separate worksheet, while other content is placed on the last 
worksheet.

• Flowing Page (FP)—This format preserves the original layout of the pages, including 
columns. This is done wherever possible with column and indent settings, but not with text 
boxes or frames. Text will then flow from one column to the other, which does not happen 
when text boxes are present. 

• True Page (TP)—This output format uses absolute positioning on the page to keep the 
original layout of the pages, including columns. This is done with text, picture and table boxes 
and frames. True Page is the only choice for documents scanned with the PDF format. It is not 
available for the TXT, RTF, CSV, or XLS formats.

• Spreadsheet—This output format produces results in a tabular form with each page 
becoming a separate worksheet. The worksheets can then be opened in a spreadsheet 
application. The Spreadsheet output option is only available for documents scanned with the 
XLS format.

2. Click OK or Apply.
These options will now apply to the OCR processing when you select any text format as the page 
format.
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One Touch with Kofax VRS Technology

The One Touch software you received with your Xerox scanner now includes the Kofax® Virtual 
ReScan® (VRS™) technology. This application has a set of features for improving and enhancing the 
quality of scanned documents, especially documents that would usually produce poorer quality 
images. For example, the AutoBrightness option analyzes the document to determine if it’s too light or 
dark to produce a clear, legible image, or if the background and highlighted areas of the image are 
indistinct. AutoBrightness then automatically adjusts the brightness. Scan configurations with VRS 
options work with One Touch scan settings to produce the best quality images.

This section explains how to use the Kofax VRS features when choosing new scan settings for your 
scanner. 

The VRS options appear on the Scan Configuration Properties window that you use to create a new 
scan configuration for your scanner.

When you first install the software, the Basic Features will be available and a button, Get VRS Pro, will 
also be on the window. If you would like to purchase VRS Professional to be able to use the Professional 
Features of VRS, click the Get VRS Pro button.

The Kofax VRS Settings

You select the Kofax VRS settings when creating or editing a scan configuration on the One Touch 
Properties window. 

Click the VRS Settings tab to see the new 
VRS options available for your scanner.
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1. Open the One Touch Properties window.

2. Click the New button to create a new configuration, or select one of your custom configurations 
you created earlier and click the Edit button.

3. Click the VRS Settings tab to see the new VRS settings.

4. Choose the Kofax VRS options for the scan configuration.
5. Click the drop-down arrow to choose the type of VRS settings to use for the new scan 

configuration. The options are:
• Do not use VRS processing—Scanning will not use the VRS processing.
• Default settings—Automatically selects the options your scanner can use with any scan 

mode (Black&White, Grayscale, and Color).
The Basic Features are:
• AutoCrop—Select this option to let the software automatically determine the size of the 

item being scanned.
• AutoDeskew—Select this option to have the software automatically determine if a page is 

skewed, then straighten its image. If the page is scanned at too great an angle, the image 
may not straighten correctly. In that case, re-scan the page.
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• AutoBrightness—Sets the brightness to achieve the best balance between the document’s 
background, foreground, and highlighted areas. This option is not available when scanning in 
Color.

• Edge Cleanup—Select this option to have the software remove any thin lines that may be 
around the edges in the scanned image. Edge Cleanup only applies if AutoCrop and 
AutoDeskew are selected so the software can determine where the edges are located. 
Therefore, selecting Edge Cleanup will also select AutoCrop and AutoDeskew. This option is 
only available when scanning in Black&White.

• Despeckle—Speckles are small spots on an image that the scanner interpreted as a valid part 
of the document. For example, an irregularity in the paper, or a small wrinkle, or the holes 
where a staple was removed may show up as speckles on the scanned image. The Despeckle 
option identifies these spots and removes them. This option is only available when scanning 
in Black&White.

6. Click OK or Apply to add the VRS options to your scan configuration.

When a scan configuration includes VRS options, the One Touch Panel and the One Touch Properties 
window both show the VRS icon as a reminder.

Technical Note

The following features are disabled in One Touch when the corresponding VRS feature is enabled.
• Scan Settings tab—Brightness and Contrast are disabled when AutoBrightness is selected on the 

VRS Settings tab.
• Page Settings tab—Straighten image, AutoCrop to original, and Edge Cleanup are disabled when 

AutoCrop, AutoDeskew, or Edge Cleanup is selected on the VRS Settings tab.

The Professional Features

If you upgrade your scanner’s VRS software to the VRS Professional version, the Professional Features 
shown at the bottom of the window become active.

The VRS icon on the top of the One Touch 
Panel and on the scan configuration remind 
you that the scan will use the VRS settings.

The summary of the scan settings also 
indicates VRS settings.
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• Advanced Clarity—Produces a clear, legible image even for documents that have complex or 
textured backgrounds, such as graph paper, blueprints, and security paper. The Advanced Clarity 
option identifies the text and drawings in the foreground and produces a scan image that keeps 
the background from obscuring them. This option is only available when scanning in Black&White.

• AutoOrientation—Recognizes text on the page and rotates the image 90, 180, or 270 degrees so 
the text is right side up. The AutoDeskew option must also be selected with the AutoOrientation 
option.

• Auto Color Detect—Determines if a document contains color or not and produces the 
appropriate scanned image. Typically, Auto Color Detect is used when you have a stack of pages 
to scan, some color and others not. Instead of you having to change the scan settings from Color 
to Black&White and back again, the scanner can choose the correct settings automatically. 

• Blank Page Deletion—Recognizes when a page is blank and removes its image. For instance, if 
you are scanning a stack of pages that includes a blank page, its image will not be included with 
the other images from the stack.

• Background Smoothing—Sometimes a document with a background color on the page will 
produce a scanned image that has small imperfections in the color. This option recognizes a 
document’s background color and makes sure it is a smooth, solid color. Background Smoothing is 
not available for Black&White scan configurations.
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7Scanning from TWAIN

This chapter includes:
• Accessing the TWAIN Interface on page 140
• Configurations Tab on page 141
• Scan Settings Tab on page 143
• Document Settings Tab on page 146
• Image Enhancements Tab on page 148
• Imprinter(s) Tab on page 152
• About Tab on page 155

You can scan from any TWAIN scanning application instead of scanning from the One Touch buttons 
on your scanner or the One Touch button panel.

A Note About Your Scanner and the TWAIN standard: TWAIN is a widely recognized standard that 
computers use to receive images from scanners, digital cameras, and other digital devices. The TWAIN 
scanning interface can be accessed from any TWAIN scanning application you have installed on the 
computer. Applications such as Nuance PaperPort and OmniPage, and many other applications, can 
use the TWAIN interface for scanning. 

The TWAIN interface, described in this section, is the one provided with your scanner and you will see it 
when scanning from PaperPort or OmniPage. Other TWAIN compliant scanning applications may also 
access this interface. However, there are some applications that have their own TWAIN interface. If you 
are scanning from a software application, and see the interface shown in this section, you can use 
these instructions to scan with the TWAIN interface. If you do not see this TWAIN interface, please 
refer to your scanning application’s user guide for instructions.

Note: You can access the TWAIN interface when you’re scanning from the One Touch software. If the 
One Touch configuration you are using is set to Configure Before Scan, and the selected option is 
TWAIN, the TWAIN interface opens right away when pressing the button on your scanner without 
opening any other TWAIN-compliant software first.
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Accessing the TWAIN Interface

Every TWAIN scanning application will access the scanner using a different method. Below is a brief list 
of common applications and how to initiate a scan from within that application, including some of the 
applications which may have been provided with your scanner.
• Visioneer One Touch: Open the One Touch Properties window and under the Configuration List 

select “Configure Before Scan”. Click on OK to save the changes, the next time you scan using that 
button the TWAIN interface will open immediately.

• Nuance PaperPort: On the Toolbar click on the Scanner icon to open the Scan Pane on the left 
side of the PaperPort desktop. Select your scanner in the Scan Pane then click on the “Scan” button 
in the Scan Pane. If you get a message that the scanner is not in the PaperPort database, follow 
the instruction on screen to run the Scanner Setup Wizard.

• Nuance OmniPage: Go to File, then Get Page, then click on Scan. If you get a message that the 
scanner is not in the OmniPage database, follow the instruction on screen to run the Scanner 
Setup Wizard.

• Adobe Software: Depending on the application you can “Create a file” then select the scanner as 
your creation source, or “Import a Picture” and select the scanner as your import from source.
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Configurations Tab

When the TWAIN interface first opens, the initial view of the Configurations tab shows the Current 
Settings profile and basic information about the scanning selections in the Summary field. The other 
tabs, Scan Settings, Document Settings, Image Enhancements, and Imprinter(s), are where you set 
these scanning options for a profile. 

The status field and buttons at the bottom of the TWAIN interface are always available. Click on the 
Scan button to initiate a scan with the current settings. Click on Cancel to discard any changes and 
close the window.

Scan Profile—click the drop arrow and select a scan profile from the list. A profile contains all features 
in the TWAIN interface, including color mode, resolution, paper size, double-feed detection, and so on. 
The buttons on the interface are for saving and distributing profiles.
• Save—click this button to save the settings in TWAIN to a profile. You will be prompted to specify 

a profile name, type in the name you want then click on OK. If you are making changes to a profile 
you have already saved, you will be asked if you want to replace the current profile. Click on Yes to 
replace the current profile settings, or No to specify a new profile name. The Current Settings 
profile shows the scan settings last used.

• Export—if you want to share your settings with another user who has these TWAIN options, you 
can export a profile then import it on another computer. After clicking the Export button, you will 
be prompted for a file name and a location to save the profile. Choose a location on your 
computer where you will be able to find it.
Xerox DocuMate 4790
User’s Guide

141



• Import—if you have exported profiles from TWAIN previously, click on import to add those 
profiles to your current profile list. Browse to the location on your computer where the profiles are 
saved, select the profile then click on Import. If you import a profile that has the same name as a 
profile you already have in the list, you will be prompted to either overwrite the current profile or 
cancel the import of that profile.

• Delete—on the Configurations tab, select a profile from the list then click on the Delete button to 
remove that profile.

Summary—this section lists some of the details of the current scan profile. These are the options 
found on the Scan Settings, Document Settings, and Image Enhancements tabs.
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Scan Settings Tab

Mode—select the color you want the image to be saved as.
• Black and White scans the image bitonal where everything on the page is either black or white. 

This setting is often used when scanning typed or written documents. When there are not a lot of 
graphics or if the graphics are not needed, this setting is ideal for archiving documents to a server 
or on a disc, emailing, or posting to a web page, as the file size is smaller than the other scanning 
modes.

• Grayscale scans the image using varying shades of gray to reproduce the document. This setting 
is often used when scanning documents or graphics where the original color does not need to be 
retained, but the graphics need to be maintained. Grayscale scanning preserves the graphic 
quality while keeping the file size less than that of a full color scan.

• Color scans the image in color, creating a full color copy of an original document. This setting is 
often used when scanning color documents where the background or images on the page are 
illegible when scanned in grayscale or black and white. Color scans have the largest file size.

Resolution—move the slider left or right to change the resolution for the scanned image. Resolution is 
the clarity of the image measured in dots-per-inch (dpi). The higher the resolution the clearer the 
image. However, high resolution scans can result in a large file size. When making copies of black and 
white documents, 100-150 dpi will create an image of similar quality to the original. When making 
copies of color documents, 150-200 dpi will create an image of similar quality to the original. Higher 
resolutions are generally used for creating an image that can be enlarged without losing image quality.
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Page type—your scanner supports both Single-Sided (simplex) and Double-Sided (duplex) scanning. If 
you only want one side of the page scanned, select Single-Sided. If your document contains 
information on both sides of the page, select Double-Sided to have both sides of the page scanned.

Page size—click the down arrow and select a pre-defined page size from the list. The available page 
sizes are within the scanner’s range of minimum and maximum item size. The list includes options that 
may be specific to your locale, such as U.S. Letter, A4, B5, etc... 

If the list does not include the page size for your scanning batch, click on Custom, then input the Width 
and Height of the document. Click on Inches to change the setting to millimeters (mm). You can only 
specify values within the scanner’s range of minimum and maximum item size. When Long Document 
is not selected, 17 inches (431.8 mm) is the maximum custom length that can be specified. 

Long document—when inputting a custom page size value, click on Long document to enable long 
paper support. When this option is selected you can scan documents with a page length up to the 
scanner maximum. Change the value in the Height field to match the length of the document you are 
scanning. If the value in the Height field is less than the actual document length, the scanned image 
will be split up across multiple pages. For example, if you are scanning a document 50 inches long, and 
the Height field is set to 10 inches, the final scan will be split across 5 images. 

Please note that you can only scan one page at a time using the Long document option. Also, the 
Detect control sheet and Detect patch codes features are disabled when Long document is enabled.

Page orientation—the Portrait or Landscape option is for you to select what direction you placed the 
pages in the scanner. Choose portrait if the papers are in the input tray with the tops in the scanner. 
Choose landscape if the papers are in the input tray with the sides in the scanner. This option is only 
available for standard paper sizes in the Page size list.

Detect control sheet—select this option to use control sheets to change the scan settings 
automatically while scanning. For example, if you are scanning a 100 page document in black and 
white, but there are certain pages you want scanned in color, you can place a “color” control sheet in 
the document stack at the section where you want to switch to color scanning. You can then put a 
binary (black & white) control sheet further down in the stack to have the scanner automatically switch 
back to black & white scanning. 

There are various types of control sheets available on the scanner’s installation disc for you to print and 
use, such as Simplex and Duplex to switch between single-sided and double-sided scanning. Please 
note that when using a control sheet that has multiple options in the TWAIN interface, TWAIN will 
always use a pre-defined setting. Currently these settings are defined for the following control sheets:
• When using the Dither control sheet, TWAIN will choose the dither method: Bayer dither (64 

steps).
• When using a Halftone control sheet, TWAIN will choose the halftone method: 0 degree halftone 

dot (64 steps).

Print and use the control sheets that are appropriate for the size of the pages being scanned. The 
scanner recognizes control sheets as follows:
• The scanner will only detect control sheets that are face-up in the document stack when scanning 

in Single-sided mode.
• When scanning in Double-sided mode, the scanner will look for the control sheet data on both 

sides of the paper.
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Manual feed mode—select this option to enable a 30-second delay from when the last page is 
scanned and when the scanner stops the scan job. This allows you to scan pages one at a time, or 
multiple separate stacks of pages, and have all pages scanned be in a single scan job when scanning is 
finished.

To scan using manual feed mode:
1. Move the mode selector switch on the scanner to MANUAL.
2. Select Manual feed mode in the TWAIN interface.
3. Place the page(s) you want scanned in the input tray.
4. Click Scan in the TWAIN interface.
5. Press the Simplex/Duplex buttons simultaneously to start scanning the page(s).
6. When scanning is finished, place the next page you want to scan and press the Simplex/Duplex 

buttons to scan that page.  
7. When you are finished scanning all pages, press the Simplex/Duplex buttons to stop the scanner, 

click the Abort button in the progress window, or simply let the timer run out.
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Document Settings Tab

Crop image to paper length—this option tells the scanner to crop the final image the bottom of the 
page being scanned. This option may occasionally be grayed out, not all TWAIN scanning applications 
support this feature. Always use the paper guides on the scanner so the page is not skewed. Skewed 
pages may not crop properly. This option is only available if the scanner supports this feature. 

Detect stapled documents—select this option to have the scanner warn you if a stapled page has 
been detected. When the scanner detects the stapled page it will stop scanning so that you can fix the 
problem and start the scan again.

Double Feed Detection (DFD)—this option detects when two or more pages are fed through the 
scanner at the same time. When this option is turned on, ultrasonic waves are aimed at the document 
to detect multiple pages by the level at which the waves pass through the pages. The accuracy of this 
sensor depends on paper thickness and whether or not creasing is in the original document. Standard 
printer paper between 16lb and 20lb works best with this feature. 
• Detect—select an option from the drop menu to turn on this feature. 

Detect only—the scanner notifies you that a double page feed has been detected but continues 
scanning.
Detect and stop—the scanner stops scanning when a double page feed has been detected and 
waits for you to correct the problem. 
You can bypass the stop, without correcting the problem, by pressing the DFS (Double Feed Skip) 
button on the scanner, or by clicking Continue in the message box on-screen.
You can stop the scan job completely by pressing the Simplex/Duplex buttons on the scanner 
simultaneously. 
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• Sensitivity—drag the slider left or right to change the DFD sensitivity level. 
• Sensors—if your scanner has multiple DFD sensors, you can turn on or off each of the sensors by 

selecting/deselecting the sensors. At least one sensor has to be selected. If your scanner has only 
one sensor, that sensor will be selected and grayed out.

Patch codes—select this option to enable patch code detection during scanning. The scanner 
recognizes patch codes as follows: 
• The front side of the page. A page with a patch code on it must be placed face-up in the 

document stack.
• A minimum of 50 mm of clear space from the top of the page to a patch code with horizontal 

lines.
• A maximum of 70 mm between the left side of the page and a patch code with vertical lines.
• A minimum of 10 mm of clear space around the patch code.
• The patch code should be a minimum of 9 mm long for best results.
• The scanner can detect Kodak patch codes 2, 3, and T.

There are various types of patch code sheets available on the scanner’s installation disc for you to print 
and use.
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Image Enhancements Tab

Invert Image—this option reverses black and white on a page, so that when scanning a white page 
with black text image will be a black page with white text. This option is available when scanning in 
black and white or grayscale.

Mirror Image—this option flips the image left-to-right.

Despeckle—removes speckles from the background. Speckles are small spots on an image that the 
scanner interpreted as a valid part of the document. For example, an irregularity in the paper, a small 
wrinkle, or holes where a staple was removed may show up as speckles in the scanned image. The 
Despeckle option identifies these spots and removes them. Despeckle is only available for the Black 
and White scanning mode.
• Speckle diameter—is where you can set the size of the speckles you want the software to look for 

and remove. The size of the speckle removal is measured in pixels. For instance, if you have small 
black dots all over the image, a value of 1 will look for black dots in the image that is exactly 1 
pixel in size. A value of 2 will remove a square block of 4 pixels, a value of 3 will remove a square 
block of 9 pixels, and so on. However, as you increase the speckle diameter the dots of “i” and “j”, 
accent marks above letters, and punctuation marks such as periods or commas, may be removed 
as well.

High speed (JPEG transfer)—when this option is selected, the pages are initially scanned and 
transferred to the computer as JPEG images. After the image transfer is complete, the images are 
compiled and saved to your selected file format in the scanning application you are using. This option 
improves scan speeds when scanning at higher resolutions.
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The availability of this option is dependent upon the type of scanning application and how that 
application is set to receive image transfer from the scanner. Also, please note the following scenarios 
in which this option may be enabled or disabled.
• Depending on your scanner model, JPEG transfer may not be available when image crop or 

deskew detection are selected on the Document Settings tab.
• This option is only available when scanning in color or grayscale.
• This option is automatically selected when the resolution is set to 400 dpi or higher. You can 

deselect this option if you do not want to use it.
• This option will be selected and grayed out if you are using a scanning application that requires 

JPEG compression.

JPEG quality—use the up and down arrows to adjust the quality of the JPEG images. This option 
adjusts the level of compression used when creating the JPEG image. 

Color dropout—tells the scanner and software to remove a specific color from the image. You can 
choose either Red, Blue or Green, or define a custom color, to be dropped out of an image. To input the 
custom color RGB value select Custom and input the value in RRR,GGG,BBB format where RRR, GGG, 
and BBB are numbers from 0 to 255. This option is only available when scanning in grayscale or black 
and white.

Brightness is the overall lightness of the image. Move the slider to the left to decrease (darken) the 
image, move the slide to the right to increase (lighten) the image. You might use this option if you are 
scanning in a document with handwritten notes using a pencil. This option is only available when 
scanning in Color and Grayscale.

Contrast refers to the difference between the light and dark portions of the image. Increasing the 
contrast emphasizes the difference between the lighter and darker portions, decreasing the contrast 
de-emphasizes that difference. This option is only available when scanning in Color and Grayscale.

Threshold technique is specific to the type of documents you are scanning. When you select a 
threshold technique the sub-panel below will update with the options available to that technique. 
These options are only available when scanning in Black and White.
• Text (threshold) enables you to set what level of light or dark text to look for on a page. When 

scanning in black and white, everything on the page is set to either white pixels or black pixels in 
the final image. If the text on the page is a light color, then the text may be gone in the final 
image as the scanner will change those light colors to white pixels. The text threshold technique 
lets you set the level of darkness or lightness of the text on the page. This option works best for 
documents that contain only text such as business letters, spreadsheets, reports, etc...

• Photo (dither / halftone / error diffusion) is the intentional application of noise in the image to 
help alleviate banding when scanning in binary (Black and White) mode. For example, if you scan 
a color photo in black and white, the image file will have large blocks of black and white and the 
image barely recognizable. Dithering the image creates a black and white image that is 
recognizable. The dither option is only available when you are scanning in Black and White.

• Mixed content (automatic separation) applies both a threshold level and a dither diffusion to 
the image. It looks at the page and breaks it up into sections of graphics and text, then applies the 
threshold and dither value to the appropriate section. This option works well when scanning items 
that have both text and graphics, such as marketing brochures. After selecting this technique, 
both sub-options for Threshold and Dither will be available.
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• Dynamic threshold enables you to set what level of light or dark text to look for on a page. When 
scanning in black and white, everything on the page is set to either white pixels or black pixels in 
the final image. If the text on the page is of a light color, then the text may be gone in the final 
image as the scanner will change those light colors to white pixels. The text threshold technique 
lets you set the level of darkness or lightness of the text on the page. 

Threshold—move the slider to the left or right to set the level of lightness or darkness for the scanner 
to leverage from. This option is only enabled if you have selected Text or Mixed Content as the 
threshold technique to use.
• For example, if you are scanning a document with gray text, such as hand written pencil notes, 

move the slider towards Light. This tells the scanner that the level to look for is light, and gray 
pixels are converted to black pixels instead of white. If the overall tone of the original document is 
dark, such as a colored background that may interfere with detecting black, move the slider 
towards Dark. This tells the scanner that the level to look for is dark, only very dark areas such as 
text are converted to black pixels.

• If you are scanning documents that are in good condition, with black text on a white background, 
the default threshold option will properly scan the item. This level only needs to be adjusted if the 
scanned image does not have image clarity similar to the original.

Dither / Halftone / Error Diffusion Method—select the dithering type you want to use from the drop 
list in the sub panel. 
• Below is an example of a color scan, a black and white scan without dithering, and a black and 

white scan with dithering (using Bayer Dither 64 steps). When the image is scaled down, it may 
look like a grayscale scan. When the image is at normal size or enlarged you will be able to clearly 
see the dithering pattern, as shown in the close-up image.

Dynamic Threshold—move the slider to the left or right to set the level of lightness or darkness for the 
scanner to leverage from. 

Full Color Black and White Bayer Dither 64 Steps

Close-up of Bayer Dither
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• For example, if you are scanning a document with gray text, such as hand written pencil notes, 
move the slider towards Light. This tells the scanner that the level to look for is light, and gray 
pixels are converted to black pixels instead of white. If the overall tone of the original document is 
dark, such as a colored background that may interfere with detecting black, move the slider 
towards Dark. This tells the scanner that the level to look for is dark, only very dark areas such as 
text are converted to black pixels.

• The threshold option in this section individually looks at each page and applies the threshold if the 
software determines that it is needed.
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Imprinter(s) Tab

Use the imprinter tab to set the options for printing data on the pages as they are scanned. The 
imprinter options are only available if you have an imprinter unit installed in the scanner. 
• Pre-imprinter—prints the character strings defined on this tab on the 

pages before the pages are scanned. These strings then appear in the 
scanned image. The pre-imprinter only prints on the simplex (face up) 
side of the page.

Orientation—select in which direction you want the text printed on the 
page. When you select an option from the list, the text to the right shows a 
preview of how the text will look on the page. 

Vertical start position—drag the slider left or right to set the start 
position on the page where you want the text printed. The starting 
position of the slider is 10mm (approximately .4 inches) as this is the 
minimum required margin from the edge of the paper. You should set the 
paper size on the Scan Settings tab before adjusting the Vertical start 
position. Click on the label “mm” or “inches” to switch between the two 
units of measurement.
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You set the horizontal start position by moving the ink carriage in the imprinter unit itself. Move the ink 
carriage left or right and align the arrow tab to the appropriate paper width indicated on the imprinter 
unit.

Text format template—the following table shows the available alphanumeric characters and symbols 
that can be printed. A maximum of 72 characters can be printed, which includes text you type in the 
input field as well as any tokens you select from the token list.

• Click the down arrow and select a token from the list, then click the arrow button to add that value 
to the character string field. You can add up to 3 tokens from this token list:
{FN}—inserts the scanner name.
{User}—inserts the user name.
{Mach}—inserts the computer name.
{#_b}—inserts the step number with spaces padding the number based on the select number of 
Counter digits. 
{#0b}—inserts the step number with “0” padding the number based on the selected number of 
Counter digits. 
{YY/MM/DD}—inserts the current date in the 2-digit Year/Month/Day format (11/01/31).
{YYYY/MM/DD}—inserts the current date in the 4-digit Year/Month/Day format (2011/01/31).
{MM/DD/YY}—inserts the current date in the Month/Day/2-digit Year format (01/31/11).
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{DD MMM.,YYYY}—inserts the current date in the Day, 3-letter Month, 4-digit Year format 
(31 Jan., 2011). 
{HH:mm}—inserts the current time in hours:minutes using the 24-hour clock format (13:30).
{HH:mm:ss}—inserts the current time in hours:minutes:seconds using the 24-hour clock format 
(13:30:01).

• Counter digits—click the up or down arrows to change the number of digits to print in the 
counting number string. You can specify 1 to 7 digits, and you must add either the token {#_b} or 
{#0b} to the character field for these numbers to be printed. 

• Starting number—click the up or down arrow to change the first number printed on the first 
page. You can also type a number directly in the field. The starting number is limited to the 
number of Counter digits you specified.

• Step value—click the up or down arrow to change how the numbers count. You can set to count 
from 1 to a maximum of 9 at a time. 

• Bold—select this option if you want everything printed in a bold font.
• Preview—this area shows what the character string will look like.

For example, if you were to input in the text field: Scanned {YY/MM/DD} - {#0b}
• With the Counting digit: 6, Starting number: 500, and Step value: 2

The resulting printed character string for a pre-imprinter on 4 pages scanned would be:
• Scanned 11/01/31 - 000500
• Scanned 11/01/31 - 000502
• Scanned 11/01/31 - 000504
• Scanned 11/01/31 - 000506
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About Tab

TWAIN Driver Information—this area shows the current driver version and scanner name. If you have 
more than one scanner, of the same model, connected to your computer you will see a counting 
number after the scanner model.

Scanner Information—this area shows the hardware specific information. 
• The Serial number is unique to each scanner, looking at different serial numbers allows the 

software to have multiple scanners of the same model installed on one computer.
• The Total number of pages scanned shows the number of pages the scanner has ever scanned.
• The Front and Back background color displays the current side of the background plate.
• The Scanner memory shows the total amount of installed memory in the scanner. 

Click the Refresh button to update the information in this window.
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8Scanning from WIA

This chapter includes:
• Scan using WIA from Microsoft Paint on page 158
• Fine Tuning Your Scans on page 160

Microsoft Windows version XP and later include their own scanning interface—known as Windows 
Image Acquisition (WIA)—for acquiring images from scanners, digital cameras, and other digital 
devices.

This section shows how to use Microsoft Paint to scan using the WIA interface, but you can use other 
Windows applications as well.

Note: Windows Vista and Windows 7 have advanced options available for scanning with the WIA 
interface. Scanning from Microsoft’s Paint application uses the interface described in this section. Other 
applications may access the advanced WIA interface available with Windows Vista and Windows 7. 
Please refer to the Windows help for instructions on using WIA.
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Scan using WIA from Microsoft Paint

1. On the Windows taskbar, click Start, point to Programs, point to Accessories, and then click Paint. 
2. From the File menu choose From Scanner or Camera. 

3. The scan window opens. Use this window to select scanning options and start the scan process. 

4. Click on the color mode appropriate for the item you are scanning.
5. Place a document in the scanner.
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6. Click on the Scan button in the WIA interface.
The scanner starts scanning.

7. The scanned image will appear in Microsoft Paint (or other WIA application you’re using).
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Fine Tuning Your Scans

You can select new settings before you scan an item to fine tune exactly how you want to scan it. 

1. On the scan window, click Adjust the quality of the scanned picture.

2. Select the options for scanning.
Brightness and Contrast—Drag the sliders to the right or left to adjust the brightness and 
contrast of the scanned image.
Resolution (DPI)—Click the up or down arrow to scroll through the dots per inch (dpi) of the 
resolution. Higher dpi settings take longer to scan and produce larger files for the scanned images.
Picture type—Click the menu arrow and choose the most appropriate type for the item you’re 
scanning. 

3. Click OK.
The Custom Settings button is now set to scan with the options you selected.
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9Scanning from ISIS

This chapter includes:
• Accessing the ISIS Interface in QuickScan on page 162

You can use the ISIS interface from QuickScan or any other application that will access the ISIS driver. 
You received QuickScan with your scanner.

Note that the ISIS interface for each application varies depending on the application. Please refer to 
that software application’s User Guide for instructions on scanning the ISIS interface. The QuickScan 
User’s Guide is available on the installation disc that you received with the scanner.
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Accessing the ISIS Interface in QuickScan

Open the QuickScan software to access the ISIS driver scanning options. Please note that you may see 
the following warning message:

1. Please disregard the message and click Continue.
The ISIS drivers were installed correctly during the installation of your scanner.
The Scanner Selection dialog box will then appear.

2. Select Xerox DocuMate 4790 from the list of scanners and click OK.

Your scanner is then ready to work with the ISIS driver.
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10Scanner Options, 
Maintenance and 
Troubleshooting

This chapter includes:
• Changing the Background Color on page 164
• Replacing the Rollers on page 166
• Installing an Imprinter on page 171
• Installing an Ink Cartridge on page 172
• Adjusting the Printing Position on page 173
• User Utility on page 174
• Cleaning the Outside of the Scanner on page 182
• Cleaning the Inside of the Scanner on page 183
• Clearing Paper Jams on page 189
• Troubleshooting on page 190
• Uninstalling Your Scanner on page 193
• Xerox DocuMate 4790 Specifications on page 194
• Xerox DocuMate 4790 Scanner Parts List on page 195

This section contains information on hardware options available for your scanner, the scanner 
User Utility, maintenance instructions, troubleshooting, uninstalling, scanner specifications, and spare 
parts.
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Changing the Background Color

You can change the scanner’s background plate color between black and white. The background color 
is important as it may affect the cropping quality of the scanned document. Each scanning application 
is different so you should choose the color (black or white) based on the best results you see in the final 
scanned document file. The default background plate is black.

Your scanner has two scanning lamps, which allows for duplex (two-sided) scanning. You must change 
the background plate for both lamps at the same time.
1. Turn off the scanner power.
2. Open the scanner. Make sure there is at least 18 inches of room above the scanner to safely open 

the scanner completely.

3. Locate the background plates in the top and bottom of the scanner. 
4. Press gently on the background and roll it to switch between black and white. The bar will click 

when it is in place.
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5. Carefully close the scanner when you are finished.
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Replacing the Rollers

Frequent paper jams are a symptom of a worn roller assembly. A worn roller can cause documents to 
feed in skewed at an angle, or multiple pages to feed at the same time. A worn roller should be 
replaced to avoid damage to the scanner’s internal parts. Before replacing the roller you should clean it 
as excessive dust on the roller will make it appear worn and smooth. You cannot properly diagnose a 
worn roller until you have cleaned it.

When replacing the rollers described in this section, you should replace all of the rollers at the same 
time. Do not replace just one roller and not the other. When you are finished replacing the roller, reset 
the roller count in the user utility as described on page 175.

Warning: keep all replaceable parts out of the reach of children. These parts are small and pose a 
choking hazard.

Turn off the scanner power then unplug the power cord from the scanner. Pull the cover release handle 
and open the scanner.

When you are done replacing the rollers, close the scanner carefully pressing down on both sides of the 
cover until it locks in place. Do not slam down the cover.
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Replacing the Feed Roller Module

1. Pull the locking lever on the left side of the feed roller module down from the scanner. This 
releases the roller module from the scanner.

2. Carefully remove the roller module from the scanner. Discard the roller module, it cannot be 
repaired or reused.

3. Take the new roller module out of its packaging.
4. Align the end of the plastic end on the right side of the roller module with the slot in the roller 

compartment. Make sure the flat side of the roller tip is aligned properly with the slot in the 
scanner.
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5. Insert the right side of the roller module into the scanner, then carefully angle the left of the roller 
module into the scanner. Be careful while inserting the roller module as the gears will engage as 
you place the module in the scanner.

6. Gently lift and hold the roller module in the scanner and then rotate the locking arm up and into 
the scanner. Make sure the roller module is securely in place before closing the scanner.

Replacing the Double Feed Prevention Roller

1. Pull up on the double feed prevention roller cover and remove it from the scanner. Set the cover 
aside and make sure nothing is set on the cover as it will break.
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2. Carefully pull and hold the black tab on the left side of the roller away from the bar.

3. Gently lift the left side of the roller bar up and then pull the roller out of the scanner toward the 
left, releasing the roller from the gears on the right side of the compartment. 

4. Discard the roller, it cannot be repaired or reused.
5. Take the roller out of its packaging.
6. Align the plastic gear end on the right side of the roller with the gears in the roller compartment. 

Make sure the flat side of the roller tip is aligned properly with the slot in the scanner.
7. Carefully insert the gear end into the scanner and angle the roller down into the left side of the 

compartment.
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8. Press gently on the metal bar on the left side to lock the roller in place with the black tab in the 
compartment.

9. Place the roller compartment cover in the scanner and lower it into place.
10. Press gently on the compartment cover to lock in the scanner. Make sure this cover is fully closed 

as it may break and cause damage to the scanner if it is not properly in place.
Xerox DocuMate 4790
User’s Guide

170



Installing an Imprinter

An imprinter unit will print text, such as a date and time stamp, on the pages as they are scanned. If 
you have a pre-imprinter unit installed, the text is printed on the face-up side of the page before the 
image is captured, and the printed text is then reflected in the scanned image. 

The imprinter unit is an optional accessory that you can purchase at www.xeroxscanners.com in the 
Parts and Accessories page for your scanner.

1. Turn off the scanner.

2. Open the pre-imprinter door.

3. Insert the pins on the right side of the imprinter unit into the holes on the scanner. Angle the 
imprinter down into the scanner until the pins on the left side line up with the slots in the scanner. 
Gently press down on the imprinter unit until it clicks in place.

4. Connect the cable to the connection port in the scanner.
5. Close the pre-imprinter door when you are finished. 
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Installing an Ink Cartridge

1. Turn off the scanner.
2. Open the imprinter door.
3. Remove the protective tape from the ink cartridge.
4. Move the ink cartridge carriage to the ink cartridge exchange position on the imprinter unit.

5. Insert the ink cartridge into the carriage as shown in the diagram.

6. Lower the arms on the carriage to lock the ink cartridge in place.

7. Reverse this procedure to remove the ink cartridge when it is time to be replaced.
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Adjusting the Printing Position

You set the horizontal start position by moving the ink carriage in the imprinter unit itself. Move the ink 
carriage left or right and align the arrow tab to the appropriate paper width indicated on the imprinter 
unit. The vertical start position is set in the scanning interface you are using.
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User Utility

The User Utility is a software program designed to help maintain and troubleshoot your Xerox scanner.

On installation you were prompted to place an icon on your Windows desktop. If you selected yes, 
simply double-click on the user utility icon to open the software. 

If you do not have the User Utility icon on your desktop, follow these instructions for opening the utility 
from the Windows programs list:
1. Click on the start button on the Windows taskbar.
2. Click on All Programs.
3. Click on Xerox from the programs list.
4. Select User Utility to open the software.

If you are prompted to select a scanner, make sure your scanner is selected then click on OK.

Main Screen Options

This section briefly describes the options on the main interface of the User Utility. The following 
sections contain detailed instructions on using some of the options in this utility.

Scanner Status—this area displays the status of the scanner connected as well as error code details.

Error Code—this field displays an error code number to help you diagnosis and resolve hardware 
errors. Please see Scanner Error Codes on page 175 for the full list of error codes and steps to resolve 
the issue.

Scanner Information—this area displays the current hardware specifications of the scanner.
• Model: the scanner hardware model.
• Firmware Version: the scanner’s current firmware version.
• Memory: the amount of memory currently installed on the scanner.
• Interface: the connection interface to the computer.
• Imprinter: indicates if an imprinter is installed in the scanner, with a status of either Enable or 

Disable, and the type of imprinter installed. The imprinter is an optional accessory that you can 
purchase for the scanner. Please refer to our website www.xeroxscanners.com for spare part 
options available for your scanner.

Scanner Condition—the options in this section relate to software settings and maintenance for the 
scanner.
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• Sleep Mode: clicking on this button opens a window for you to set the time frame for your scanner 
to go into power saving mode. Please see Setting Sleep Mode on page 178 for instructions.

• Clean Imprinter: clicking on this button initiates an automatic cleaning of the print head on the 
ink cartridge installed in the imprinter. When the imprinter is not installed this button is disabled.

• Buzzer Setting: clicking this button opens a window for you to turn on or off the scanner beep 
sounds.

• User Shading: clicking on this button initiates the shading adjustment utility. The shading 
adjustment helps to improve image quality of scanned documents. Please see Shading 
Adjustment on page 178 for instructions.

• Caution Setting: clicking this button opens a window for you to set when to receive a notice that 
it is time to clean the rollers.

Scanner Counter—this section shows the number of pages scanned. Use the options in this window to 
keep track of maintenance performed on the scanner.
• System: displays the number of pages scanned through the ADF after the last counter update.
• After Clean Roller: displays the number of pages scanned after the last time the rollers were 

cleaned and the counter reset. Please see Cleaning the Inside of the Scanner on page 183 for 
instructions on monitoring and changing this setting.

• After Replace Roller: displays the number of pages scanned after the rollers have been replaced 
and the counter reset. Please refer to our website www.xeroxscanners.com for spare parts options 
and instructions available for your scanner.

• Update All Counters: clicking this button updates the current count display next to the 3 fields 
described directly above. The counters do not update automatically during document scanning, 
you must click on this button to display the current count information.

• Clear Counter: clicking either of these buttons clears the counters back to 0 for the appropriate 
section.

About—click on the About button to see more information about the application.

Help—clicking on this button opens the help file in the Adobe® PDF format.

Select Scanner—clicking on this button opens a window for you to select a different scanner if you 
have multiple scanners installed.

Save Info—clicking on this button opens a Windows Save As dialogue for you to save the current 
scanner and computer information into a .log file. 

Close—clicking this button closes the User Utility.

Scanner Error Codes

If an error occurs during scanning the LCD will display an error code and you can use the User Utility to 
troubleshoot and resolve the issue. The User Utility displays an error code and message in the Scanner 
Status field. The following table lists the codes, messages, possible causes and common resolutions. 
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If you are unable to resolve the issue using the troubleshooting steps in this table, please refer to the 
section Troubleshooting on page 190.

Error 
Code Message Cause Resolution

U11 - U18 Paper Jam and Paper 
Remains in Scanner 
errors.

Paper has jammed while 
being fed through the 
scanner. 

Document sensors are 
dirty.

Open the scanner, remove the pages, then 
close the scanner. Please see page 189 for 
complete instructions.

If problem persists, clean the rollers and 
paper sensors as described in the section 
Cleaning the Inside of the Scanner on 
page 183.

U20 A skew error has 
occurred. 

A page was pulled into 
the scanner at an angle.

Open the scanner, remove the pages, then 
close the scanner. Adjust the paper guides to 
the document width. Restack the paper in 
the ADF and click Retry to continue. 

If problem persists, clean the rollers and 
paper sensors as described in the section 
Cleaning the Inside of the Scanner on 
page 183.

U23 A paper double feed 
has occurred.

Two pages have fed 
through the scanner at 
the same time.

Open the scanner, remove the pages, then 
close the scanner. Make sure there are no 
pages stuck together. Restack the paper in 
the ADF and click Retry to continue.

If problem persists, clean the rollers and 
paper sensors as described in the section 
Cleaning the Inside of the Scanner on 
page 183.

U24 - U26 A stapled document 
has been detected.

Either the page bent 
when it was picked up 
from the input tray, or 
the page skewed greatly 
as it was pulled into the 
scanner.

Open the scanner, remove the pages, then 
close the scanner. Check all documents and 
remove any staples. Restack the paper in the 
ADF and click Retry to continue

U30 - U34 A cover is open. A scanner access cover is 
open.

Verify all covers on the scanner are fully 
closed before scanning.
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Fxx System error occurred. An unknown system error 
has occurred.

Reset the scanner and computer:
1. Turn off the scanner power.
2. Unplug the USB cable and power from 

the scanner.
3. Reboot (restart) the computer.
4. Plug the USB cable and power cable 

back into the scanner.
5. Turn the scanner back on.
If you are still unable to scan, contact Xerox 
Technical Support. Please refer to the Techni-
cal Support Card you received with the scan-
ner for contact information.

— **Warning**
The rollers need to be 
cleaned.

The number next to 
After Clean Roller:, in 
the User Utility main 
screen, has exceeded the 
maximum number 
between cleaning.

The rollers should be cleaned every 20,000 
scans, or as needed if your scanner is experi-
encing frequent paper feed issues. After 
cleaning the rollers click on Clear Counter to 
reset the cleaning roller count back to 0. 
Please refer to Cleaning the Inside of the 
Scanner on page 183.

— **Warning**
The rollers need to be 
replaced.

The number next to 
After Replace Roller:, in 
the User Utility main 
screen, has exceeded the 
maximum number 
between replacement.

The rollers should be replaced every 300,000 
scans, or as needed if cleaning the rollers 
does not improve paper feeding issues. After 
replacing the rollers click on Clear Counter to 
reset the roller replacement count back to 0.

— **Warning**
Insufficient front light 
error occurred.
Insufficient back light 
error occurred.

Either the lamp is not 
bright enough or the 
scanning sensor is not 
registering the light 
strength.

Contact Xerox Technical Support or your 
authorized service technician. Please refer to 
the Technical Support Card you received with 
the scanner for Xerox contact information.

— **Warning**
The front reference 
plate is dirty.
The back reference 
plate is dirty.

The front or back scan-
ning background plate is 
dirty.

Clean the background reference plates as 
described in the section Cleaning the 
Inside of the Scanner on page 183.

— **Warning**
The scanner’s image 
sensor cover is dirty 
and requires routine 
cleaning.

The image sensor cover 
in the scanner is dirty.

Clean the image sensor as described in the 
section Cleaning the Inside of the Scan-
ner on page 183.

— **Warning**
Scanner is not con-
nected.

The power is off, the 
power cord or USB cable 
is unplugged.

Verify cables are securely plugged into the 
scanner, computer and wall. If needed, 
reboot the computer.

Error 
Code Message Cause Resolution
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Setting Sleep Mode

Your scanner has a built-in power saving feature that sets the scanner into low power when the scanner 
has been sitting idle for 15 minutes. This default setting conserves power and complies with the 
ENERGY STAR requirements. Power saving extends the life of the lamps by turning them off when not 
in use.
1. Open the scanner User Utility application.
2. On the main window click on the Sleep Mode button.
3. When the Sleep Mode window opens, select the options you want.

Waiting Time—you can click the up or down arrows to change the Sleep Mode time from 1 to 60 
minutes, or you can type a numerical value in the text box between 1 and 60.

4. Click OK to save the changes and close the Sleep Mode window.

Buzzer Setting

1. Open the scanner User Utility application.
2. On the main window click on the Buzzer Setting... button.
3. When the Buzzer Setting window opens, select the option you want.

Buzzer Setting—click on either On or Off to set the scanner alert sounds. Scanner alert sounds 
include double-page-feed detection, paper jam error, lamp errors, etc...

4. Click on OK to save the changes and close the window.

Shading Adjustment

The shading adjustment is used to improve the image quality of the scanned documents. If your final 
scanned files are of poor quality, such as perpendicular lines or the image clarity is uneven across the 
page, you may need to perform a shading adjustment on the scanner.

To prepare for shading adjustment:

• Clean the scanner rollers, image sensors, glass and reference plates, as described in the section 
Cleaning the Inside of the Scanner on page 183.
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• After cleaning the scanner, do a test scan and view the final image file. Do not perform a shading 
adjustment until after you clean the scanner and test scan. A shading adjustment performed 
before cleaning the scanner may result in degraded image quality.

• Have the Shading Paper, provided with your scanner, ready as the software will tell you when to 
insert it into the scanner.

• Make sure the Shading Paper is in-like new condition. 
The Shading Paper should be kept in the plastic bag between the stiff cardboard when not in use. 
If the Shading Paper is creased, torn, soiled, crumpled or dirty, the image quality will degrade 
instead of improve after performing the Shading Adjustment. 
If your Shading Paper is not in like-new condition, please order a replacement at 
www.xeroxscanners.com in the Parts & Accessories page for your scanner.

• Change the front and back background reference plates to white. Please refer to the instructions in 
section Changing the Background Color on page 164. During the shading adjustment you will 
need to change the background color to white then to black. After the shading adjustment is 
complete, choose the color you want the background to be.

To complete a shading adjustment:

1. Open the scanner User Utility application.
2. On the main window click on the User Shading... button.
3. Click on Start Shading to begin the shading adjustment. The shading adjustment utility will guide 

you through the rest of the steps.

4. When prompted to clean the scanner click on OK to proceed only if you have already cleaned the 
scanner during preparation. Otherwise, follow the instructions on screen and clean the scanner.
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5. Change the background plates to white then click on OK to proceed. 
Close the scanner before continuing with the shading adjustment.

If you have already changed the plates to white you will not see the above message. Proceed to 
the next step.

6. Place the Shading Paper in the scanner’s input tray in the Landscape position then click on OK.

7. The scanner will pull the Shading Paper through as it sets the adjustment for the white 
background plate. The Now Adjusting message box will close automatically when the white 
background Shading Adjustment is complete.

8. After the white background shading adjustment is complete, you will be prompted to change the 
background plate to black to continue with the black background shading adjustment.
Change both the front and back scanning background reference plates to black then click on OK.

Note: Do not place the Shading Paper in the scanner. The Shading Paper is not used for the black 
background shading adjustment.

Note: Do not stop the shading adjustment after it has started. When the scanner pulls the shading 
paper in it will pause several times. This is the expected behavior. The shading adjustment with the 
shading paper will take about 5 minutes to complete.
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9. The Now Adjusting message box will close automatically when the black background Shading 
Adjustment is complete.

10. Click on OK to complete the shading adjustment.

Restoring the Default Shading Adjustment

You can reset the shading adjustment to the factory default setting if completing a shading 
adjustment does not improve the image quality. 
1. Open the scanner User Utility application.
2. On the main window click on the User Shading... button.
3. Click on the Restore Default button.

4. Click on OK to restore the factory default adjustment.
5. When the adjustment has been restored, click on OK to close the User Utility shading restore 

window.
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Cleaning the Outside of the Scanner

Excessive dust accumulation around and on the scanner will pull into the scanner during the scanning 
process and clog the ventilation openings. You should clean the outside of the scanner at least once a 
month to help limit the amount of dust build up in the scanner.

Note: You will need the blower brush provided with your scanner and a soft dusting cloth to clean the 
scanner.

1. Turn off the scanner power.
2. Using the blower brush, brush away any dust build up around the ventilation openings. 

3. Using a soft dusting cloth, wipe down the body of the scanner, input tray and exit area. Make sure 
that the input and exit slots in the scanner are also clean. 

4. If there is any accumulation of dust in the indentations around the buttons, use the blower brush 
to gently brush away the dust.

5. When you’re finished, press the power button to turn the scanner back on.
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Cleaning the Inside of the Scanner

Cleaning the inside of the scanner helps to keep your scanner operating at optimum performance. You 
should clean the inside of the scanner at least once a week or after 20,000 pages have been scanned. 
If you are getting frequent paper jams, multiple pages feeding at the same time, or you’re seeing lines 
in the scanned image, it is time to clean the scanner.

Note: When cleaning the rollers, do not rub the roller cleaning paper vigorously back and forth across 
the roller, this will shred the roller cleaning paper and leave debris in the scanner.

Safety Precautions

Warning: The roller cleaning paper is moistened with Isopropyl rubbing alcohol. Please read and follow 
these precautions to ensure your safety.
• Keep the roller cleaning paper away from fire, heaters or any open flame or heat source as any 

form of alcohol is flammable.
• Wear protective gloves as the roller cleaning paper may irritate sensitive skin.
• Only clean the rollers and scanning areas, as described in this section, with the roller cleaning 

paper.
• Do not leave the roller cleaning paper or bag where children can access it.
• Always turn off the scanner and unplug the scanner’s power and USB cable prior to using the roller 

cleaning paper.

Preparation

• You will need one of the roller cleaning papers provided with your scanner. Each roller cleaning 
paper should only be used once. Additional roller cleaning papers can be purchased from our 
website at www.xeroxscanners.com in the Parts & Accessories page for your scanner.

• When cleaning the inside of the scanner, you should clean all of the rollers, scanner glass and 
background plates at the same time.

• Use scissors to open the roller cleaning paper bag, cutting across the dotted line.
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Cleaning the ADF Rollers

1. Pull on the scanner cover release and lift the lid to open the scanner.

2. The following illustration shows where the rollers are located in the scanner. 
Use a roller cleaning paper to clean all of the rollers indicated in the illustration.
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Reset the Roller Count in the User Utility

After cleaning the scanner you need to reset the roller count in the User Utility.
1. Open the User Utility application.
2. From the main screen click on Clear Counter next to the field After Clean Roller.
3. The clean roller count will now be reset to 0. 
4. Close the User Utility.

Cleaning the Scanner Glass and Background Plates

1. Pull on the scanner cover release and lift the lid to open the scanner.

2. The following illustration shows the location of the glass and background plates in the top and 
bottom of the scanner. The background plates are rollers that you can rotate to change from black 
to white. While cleaning the background plates, rotate the bars to clean the entire surface.

Note: Be careful when cleaning the rollers. All of the rollers, except the free rollers, are designed to 
rotate in one direction only. Do NOT force the roller to rotate in the opposite direction. Forcing the 
roller to rotate will damage it, and cause the scanner to feed pages incorrectly.
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3. Use a soft cloth to wipe off the scanner glass and background plates. If there is sticky residue on 
either surface you can use the roller cleaning paper to remove it.

Cleaning the Paper Sensors

The scanner has several sensors to detect the status of the paper when it is in the scanner. You should 
clean these sensors as part of your standard weekly maintenance of the scanner.

Note: Do not clean the sensors with the roller cleaning paper.

Preparation

• Turn off the scanner prior to cleaning the sensors.
• Locate the Blower Brush accessory that was provided with your scanner, this is what you will use to 

clean the sensors.
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• Remove the brush tip from the Blower Brush and set it aside, you will be using only the blower to 
clean the sensors.

Cleaning the ADF Sensors

1. Pull on the scanner cover release and lift the lid to open the scanner.

2. The following illustration shows the location of the sensors in the scanner. 
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3. Point the tip of the blower at the sensor and squeeze the blower to direct a puff of air at the 
sensor head to remove dust.
Do this for each sensor in the scanner.
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Clearing Paper Jams

If your scanner stops scanning due to a paper jam in the Automatic Document Feeder, use the 
following procedure to remove the paper from the scanner.
1. Pull on the scanner cover release and lift the lid to open the scanner.

Do not attempt to remove a jammed page with the ADF door closed.

2. Remove the jammed page from the scanner.
3. Close the ADF door and continue scanning.

To reduce the number of paper jams, smooth and straighten the paper before scanning and adjust the 
paper guides to the paper size.
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Troubleshooting

Problem: The scanner won’t scan. What’s wrong? 

Check for one of these possible problems:
• Are the cables loose or not plugged in securely? Inspect the cable connections. Make sure the 

cables are plugged in securely.
• Is the scanner’s status light on? Turn on the scanner’s power. If the status light doesn’t come on, 

plug the power supply into another electrical outlet. If you are using a UPS battery back-up or 
power strip, try plugging the scanner directly to a wall outlet.

• Did you restart the computer and scanner? If the scanner gets a paper jam, or looses connection 
because of an error, try restarting your computer and power cycling the scanner.

• Did you plug the scanner into a USB hub? If you’re using a USB hub to connect the scanner try 
plugging the scanner’s USB cable directly to the back of the computer. It is not recommended that 
you use the scanner with a USB hub, if you are using a hub, the hub must have its own power 
supply.

• Is the USB cable 6’ or less? If you are using a USB cable that is longer than 6’ you may lose 
connection to the scanner. The recommended USB cable length is 6’ or less, the USB cable 
provided with your scanner is within this range.

• Did you select another image source in the scanning software? If you use multiple imaging 
devices with your computer, such as a camera, all-in-one printer, or another scanner, you may have 
selected another source for images. Make sure Xerox DocuMate 4790 is the selected scanner.

Problem: The scanned images are of poor quality. What do I do?

There are various reasons why the scanned image is of poor quality. The original document may not be 
of good quality, the scanner glass may be dirty, or a shading adjustment may be needed.
• If the original is crinkled, torn, dirty or smudge, try scanning from the Kofax Virtual ReScan (VRS™) 

software. VRS is a powerful image enhancement application that you can use to filter this type of 
noise from the document during image processing. The resulting image is of a quality equal or 
greater to the original.

• Try cleaning the scanner. The scanner glass is where the image is captured as the page is pulled 
through the scanner. Lift up on the exit release, under the input tray, to open the scanner. There is 
glass in the body of the scanner and underneath the lid. Take a soft cloth and wipe across both 
pieces of glass. The section Cleaning the Scanner Glass and Background Plates on page 185 
contains thorough instructions for cleaning this part of the scanner.

• If cleaning the glass does not improve the image quality, try performing a shading adjustment. 
The shading adjustment recalibrates the scanner. Please see the section Shading Adjustment on 
page 178 for instructions.

Problem: I got an “SVS001” error when installing Kofax VRS. What do I do?

The message “SVS001: The VRS installation does not install an ISIS driver for the scanner you selected. 
Please install the ISIS driver packaged with your scanner.” is not an error message. Please click on OK to 
finish the installation. 
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This is a message informing you that the software does not install an ISIS driver. This is the correct 
behavior of the Kofax VRS software, the ISIS driver for your scanner was installed when you chose an 
ISIS installation option when installing the scanner driver. 

Problem: Why does my scanner not function after performing a system restore on Windows XP or 
Windows Vista?

The system restore process may have corrupted some of the driver components. It is recommended 
that you reinstall your scanner driver. Please refer to Uninstalling Your Scanner on page 193 for 
installation instructions.

Problem: Why won’t my scanner buttons work after scanning with Windows Image Acquisition 
(WIA)?

After performing a scan using the WIA interface you must close the application you were using before 
scanning with the buttons on the scanner. This does not occur when scanning using the TWAIN or ISIS 
interface.

Problem: Why won’t my scanner work after the computer has been sitting idle for several hours?

To resolve the problem, simply turn off the scanner power then turn it back on again.

This may occur after Windows goes into power saving mode to “hibernate” the computer into a low 
power state. When you move your mouse or type on the keyboard it “wakes” the computer back up and 
restores full power to the system. This power fluctuation during the computer’s hibernating period may 
sometimes cause the scanner to lose communication to the computer.

Problem: The USB cable was unplugged while scanning, now the scanner won’t work. What should 
I do?

Simply turn off the scanner power then turn it back on again. This will reset the scanner and make it 
available for scanning.

Problem: When using "Create single image files" not all of the pages scanned are sent to the 
destination I chose. Where are they?

There are a limited number of times that an application can open. When "Create single image files" is 
selected and you are scanning to a destination application, each side of the page scanned will open a 
new instance of that application. If you want to have an image open in an application immediately, 
limit your scan batch to less than 5 pages.

Alternatively, you can set your destination to be a folder location on your computer or network using 
"Transfer to Storage". Select any file format and then scan a large batch of papers. At the end of 
scanning, the driver will immediately save all pages scanned to that folder location without opening an 
application.

Problem: I have selected "Skip Blank Originals" but not all of the blank pages have been removed. 
Why are there still blank pages in the file? 

If you are scanning light weight paper, such as 16lb or 18lb printer paper, the scanner may be picking 
up faint images through the paper and the driver will not drop those pages out of the final file. The 
"Skip Blank Originals" result will vary based on the DPI range and paper weight. Generally 100 dpi or 
150 dpi produces the best results.
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Problem: I tried to 'Repair' the One Touch application by using the 'Change' function through the 
Add/Remove Program within the Control Panel and was not able to repair it. How do I repair 
One Touch?
1. Before attempting to repair One Touch, unplug the USB cable connected to the scanner. 
2. Perform the Change/Repair function again. If you are asked for the Install DVD, insert the disc into 

the DVD-ROM player and click OK. 
3. When prompted, plug the USB cable back into the scanner. 
4. When the installation process finishes, click OK on the Complete The Installation window, and 

then click Close. 
5. Reboot your computer.

Problem: One Touch no longer functions after installing Internet Explorer 7 on Windows XP. How 
do I resolve this issue?

This is a known issue where One Touch stops responding when Internet Explorer 7 is installed after the 
scanner. To resolve the issue:
1. Open the Windows Add/Remove Programs feature from the Control Panel. 
2. Find Windows Internet Explorer 7 and uninstall it using the change/remove options. Follow the 

wizard through a complete removal of the Internet Explorer 7 software. 
3. Find One Touch and uninstall it using the change/remove options. Follow the wizard through a 

complete removal of the One Touch program. 
4. Unplug your scanner's USB cable from the computer. 
5. Reboot your computer. 
6. Install Internet Explorer 7. 
7. Install your scanner driver.

Problem: I am getting an error message that OCR fails every time I try to scan using the OCR 
features from One Touch. What is the problem?

Anti-SpyWare software that is set to always run may interfere with the driver functionality. It is 
recommended that you temporarily disable or suspend the automatic protection feature during 
scanning. After scanning is complete and your file has been saved, turn the auto-protect feature back 
on. You do not need to close the Anti-SpyWare software.
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Uninstalling Your Scanner

To uninstall the Xerox DocuMate scanner, remove the scanner software, and any other scanning 
software provided with the scanner.

When uninstalling the scanner driver or One Touch, please leave the scanner's USB cable plugged into 
the computer. Unplug the USB cable from the computer after the software uninstall program closes.

Uninstalling the Scanner and One Touch Software 
1. On the Windows taskbar, click Start, point to Settings, then click Control Panel.
2. Windows XP: Double-click the Add/Remove Programs icon.

Windows Vista and Windows 7: Double-click the Programs and Features icon.
3. From the list of programs, select Xerox DocuMate 4790 Driver.

Click the Change/Remove or Uninstall button.
4. Click Yes when asked to confirm that you want to remove these software programs.
5. Follow these same steps to select and remove the One Touch software, the Kofax VirtualReScan 

and the One Touch ScanSoft OmniPage OCR modules from the installed programs list.
6. The scanner driver and One Touch software is removed from your computer.
7. Unplug the USB cable from the scanner.
8. Close all open windows and restart your computer.

Uninstalling the OmniPage Software
1. On the Windows taskbar, click Start, point to Settings, then click Control Panel.
2. Windows XP: Double-click the Add or Remove Programs icon.

Windows Vista and Windows 7: Double-click the Programs and Features icon.
3. Select OmniPage and click Remove.
4. A message window opens, asking if you are sure you want to remove OmniPage from your 

computer. Click Yes.
5. Close all open windows and restart your computer.
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Xerox DocuMate 4790 Specifications

Optical resolution 600 dpi
Bit depth 24-bit color, 8-bit grayscale, 1-bit bitonal (black & white)
Scan method Duplex Automatic Document Feeder (ADF)
ADF specifications
Maximum item size 12" x 100" (305 mm x 2540 mm)
Minimum item size 1.9" x 2.8" (48 mm x 71 mm)
Scanning Speed Portrait

- 70 pages per minute / 140 images per minute @ 200 dpi
Landscape
- 90 pages per minute / 180 images per minute @ 200 dpi

Capacity 200 pages of 20lb printer paper (75 g/m2)
Paper Thickness 5 ~ 42 lbs. (20 ~ 158 g/m2)
Image Sensor Dual CCD
Light source Dual LED lamps
Interface Hi-Speed USB 2.0, compatible with USB 1.1
Scanner dimensions
Width 18.50 inches (468 mm)
Depth 17.50 inches (444 mm)
Height 13.40 inches (339 mm)
Weight 39.7 pounds (18 kg)
Operating temperature 59° ~ 86° F (15° ~ 30° C without condensation)
Relative humidity 20% ~ 80% (@30° C without condensation)
Power supply 100-240Vac
AC Power cord US—2P+G, 10A/125V, L=2000mm, 3X18AWG, BLACK, RoHS

EUR(CEE)—2P+G, 10A/250V, 3*1.00mm2, L=2000mm, BLACK, RoHS
UK(BS/PSB)—2P, 10A/250V, 3*1.00mm2, L=2000mm, BLACK, RoHS

Power consumption ≤ 100 Watts (during operation)
≤ 35 Watts (on standby)
≤ 3.5 Watts (power save after 15 minutes without scanning, can be adjusted by software)
0 Watt (power off)

USB cable 2400mm, 28AWG, RoHS compliant
Safety and agency 
certifications

UL, C-UL, TUV/GS, FCC Class A, CE, CB, WEEE, RoHS, ENERGY STAR

Supported Operating 
Systems

Microsoft Windows
- 32-bit XP (Service Pack 2 or 3)
- 32-bit or 64-bit Vista (with or without Service Pack 1 or 2)
- 32-bit or 64-bit 7

Scanner Drivers TWAIN, WIA, ISIS
Bundled Software Visioneer OneTouch®

Nuance OmniPage®
Adobe® Reader®
EMC Captiva QuickScan™
Kofax Virtual ReScan® (VRS™)
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Xerox DocuMate 4790 Scanner Parts List

Please use the following part names and numbers when ordering replacements for your scanner.

Part Name Part Number

Roller Exchange Kit
• Double Feed 

Prevention Roller
• Feed Roller Module

70-0565-000

USB Cable 35-0113-000

Power Cord 35-0233-000 (U.S.)
35-0235-000 (EUR)
35-0236-000 (U.K.)

Blower Brush 57-0122-000

Roller Cleaning Paper 05-0722-000

Shading Paper 05-0724-000

Imprinter kit 70-0537-100
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ARegulatory Information

This chapter includes:
• Basic Regulations on page 198
• Copy Regulations on page 200
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Basic Regulations

United States (FCC Regulations)

This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference when the equipment is operated in a commercial environment. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in 
accordance with the instruction manual, may cause harmful interference to radio communications.

Operation of this equipment in a residential area is likely to cause harmful interference in which case 
the user will be required to correct the interference at his own expense.

Warning: In order to allow this equipment to operate in close proximity to Industrial, Scientific and 
Medical (ISM) equipment, the external radiation from ISM equipment may have to be limited or 
special mitigation measures taken.

Changes and modifications to this equipment not specifically approved by Xerox may void the user’s 
authority to operate this equipment.

Shielded cables must be used with this equipment to maintain compliance with FCC regulations.

European Union

The CE mark applied to this product, symbolizes Xerox’s declaration of conformity with the following 
applicable European Union Directives, as of the dates indicated:

December 12, 2006: Council Directive 2006/95/EC as amended. Approximation of the laws of the member 
states related to low voltage equipment.

December 31, 2004: Council Directive 2004/108/EC as amended. Approximation of the laws of the member 
states related to electromagnetic compatibility.
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A full declaration of conformity, defining the relevant directives and referenced standards, can be 
obtained from your Xerox Limited representative or by contacting:

Environment, Heath and Safety
The Document Company Xerox
Bessemer Road
Welwyn Garden City
Herts
AL7 1HE
England, Telephone +44 (0) 1707 353434

Other Regulations

Turkey (RoHS Regulation)

In compliance with Article 7 (d) We hereby certify "It is in compliance with the EEE Regulation". 

(“EEE yönetmeliğine uygundur“)
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Copy Regulations

United States

Congress, by statute, has forbidden the reproduction of the following subjects under certain 
circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such 
reproductions.
1. Obligations or Securities of the United States Government, such as:

Bonds and Obligations of certain agencies of the government, such as FHA, etc.
Bonds. (U.S. Savings Bonds may be photographed only for publicity purposes in connection with 
the campaign for the sale of such bonds.)
Internal Revenue Stamps. (If it is necessary to reproduce a legal document on which there is a 
canceled revenue stamp, this may be done provided the reproduction of the document is 
performed for lawful purposes.)
Postage Stamps, canceled or uncanceled. (For philatelic purposes, Postage Stamps may be 
photographed, provided the reproduction is in black and white and is less than 75% or more than 
150% of the linear dimensions of the original.)
Postal Money Orders.
Bills, Checks, or Drafts of money drawn by or upon authorized officers of the United States.
Stamps and other representatives of value, of whatever denomination, which have been or may 
be issued under any Act of Congress.

2. Adjusted Compensation Certificates for Veterans of the World Wars.
3. Obligations or Securities of any Foreign Government, Bank, or Corporation.
4. Copyrighted material, unless permission of the copyright owner has been obtained or the 

reproduction falls within the “fair use” or library reproduction rights provisions of the copyright 
law. Further information of these provisions may be obtained from the Copyright Office, Library of 
Congress, Washington, D.C. 20559. Ask for Circular R21.

5. Certificates of Citizenship or Naturalization. (Foreign Naturalization Certificates may be 
photographed.)

6. Passports. (Foreign Passports may be photographed.)
7. Immigration Papers.
8. Draft Registration Cards.

Certificates of Indebtedness National Bank Currency

Coupons from Bonds Federal Reserve Bank Notes

Silver Certificates Gold Certificates

United States Bonds Treasury Notes

Federal Reserve Notes Fractional Notes

Certificates of Deposit Paper Money
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9. Selective Service Induction Papers that bear any of the following Registrant’s information:

Exception: U. S. Army and Navy discharge certificates may be photographed.
10. Badges, Identification Cards, Passes, or Insignia carried by military personnel, or by members of 

the various Federal Departments, such as FBI, Treasury, etc. (unless photograph is ordered by the 
head of such department or bureau.) 

11. Reproducing the following is also prohibited in certain states: Automobile Licenses — Drivers’ 
Licenses — Automobile Certificates of Title.

The above list is not all inclusive, and no liability is assumed for its completeness or accuracy. In case of 
doubt, consult your attorney.

Canada

Parliament, by statute, has forbidden the reproduction of the following subjects under certain 
circumstances. Penalties of fines or imprisonment may be imposed on those guilty of making such 
copies.
1. Current bank notes or current paper money.
2. Obligations or securities of a government or bank.
3. Exchequer bill paper or revenue paper.
4. The public seal of Canada or of a province, or the seal of a public body or authority in Canada, or 

of a court of law.
5. Proclamations, orders, regulations or appointments, or notices thereof (with intent to falsely cause 

same to purport to have been printed by the Queen’s Printer for Canada, or the equivalent printer 
for a province).

6. Marks, brands, seals, wrappers or designs used by or on behalf of the Government of Canada or of 
a province, the government of a state other than Canada or a department, board, Commission or 
agency established by the Government of Canada or of a province or of a government of a state 
other than Canada.

7. Impressed or adhesive stamps used for the purpose of revenue by the Government of Canada or 
of a province or by the government of a state other than Canada.

8. Documents, registers or records kept by public officials charged with the duty of making or issuing 
certified copies thereof, where the reproduction falsely purports to be a certified copy thereof.

9. Copyrighted material or trademarks of any manner or kind without the consent of the copyright 
or trademark owner.

The above list is provided for your convenience and assistance, but it is not all inclusive, and no liability 
is assumed for its completeness or accuracy. In case of doubt, consult your solicitor.

Earnings or Income Dependency Status

Court Record Previous military service

Physical or mental condition
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Other Countries

Copying certain documents may be illegal in your country. Penalties of fine or imprisonment may be 
imposed on those found guilty of making such reproductions. 

Note: This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case 
of doubt, contact your legal counsel.

• Currency notes 
• Bank notes and cheques 
• Bank and government bonds and securities 
• Passports and identification cards 
• Copyright material or trademarks without the consent of the owner 
• Postage stamps and other negotiable instruments 
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BCompliance Information

This chapter includes:
• Product Recycling & Disposal on page 204
• Energy Star for the USA on page 205
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Product Recycling & Disposal

USA & Canada

If you are managing the disposal of your Xerox product, please note that the product contains lamp(s) 
with mercury, and may contain lead, Perchlorate and other materials whose disposal may be regulated 
due to environmental considerations. The presence of these materials is fully consistent with global 
regulations applicable at the time that the product was placed on the market. For recycling and 
disposal information, contact your local authorities. In the United States, you may also refer to the 
Electronic Industries Alliance web site: http://www.eiae.org/. 

Perchlorate Material - This product may contain one or more Perchlorate-containing devices, such as 
batteries. Special handling may apply, please see: http://www.dtsc.ca.gov/hazardouswaste/
perchlorate/.

European Union

RoHS and WEEE Compliance

This product is compliant with RoHS Regulations of the European Parliament and Council Directive on 
the Restrictions of the Use of Certain Hazardous Substances in Electrical and Electronic Equipment 
(2002/95/EC), and with the Waste Electrical and Electronic Equipment (WEEE) Directive (2002/96/EC). 

Some equipment may be used in both a domestic/household and a professional/business application.

Professional/Business Environment 

Application of this symbol on your equipment is confirmation that you must dispose of 
this equipment in compliance with agreed national procedures. In accordance with 
European legislation, end of life electrical and electronic equipment subject to disposal 
must be managed within agreed procedures. 
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Energy Star for the USA

Energy Program Compliance

The Xerox DocuMate 4790 is ENERGY STAR qualified under the ENERGY STAR Program Requirements 
for Imaging Equipment.

The ENERGY STAR and ENERGY STAR MARK are registered United States trademarks. The 
ENERGY STAR Imaging Equipment Program is a team effort between U.S., European Union and 
Japanese governments and the office equipment industry to promote energy-efficient copiers, 
printers, fax, multifunction machine, personal computers, and monitors. Reducing product energy 
consumption helps combat smog, acid rain and long-term changes to the climate by decreasing the 
emissions that result from generating electricity. 

Xerox ENERGY STAR equipment is preset at the factory. Your machine will be delivered with the timer 
for switching to Power Save Mode from the last copy/print out, set at 15 minutes. A more detailed 
description of this feature can be found in the Machine Setup Section of this guide.
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Index
A
Actual size, 86
Add Application, 102, 109, 111
Adobe® Reader®, 40
Advanced Clarity, 138
Advanced device settings, 86
Advanced Settings tab, 65
After Clean Roller, 175
After Replace Roller, 175
Apply button, 57
Aspect ratio, 86
Auto Color Detect, 138
AutoBrightness, 137
AutoCrop, 136
AutoCrop to Original, 63
AutoDeskew, 136
AutoOrientation, 138
AutoRotate image, 86

B
Background Color, 164
Background Smoothing, 138
bit depth, 194
Black and White, 143
Black&White mode, 62, 64
Blank Page Deletion, 138
BMP file format, 69, 70
Brightness, 63, 149, 160
Burn to CD, 83

Destination application, 83
Buzzer Setting, 175, 178

C
Caution Setting, 175
CD burner, 83
CD-ROM drive, 17
Center image, 86
Clean Imprinter, 175
Clear Counter, 175
Collate copies, 86
Color, 143
Color Dropout, 149
Color Filter, 65
Color mode, 62, 74, 158
Comma Delimited, 124
components, 19
computer specifications, 17
Configure Before Scan, 61, 74, 139

cancel, 75
Contrast, 63, 149, 160
Copy button, 57
Create single image files, 69
Crop image to paper length, 146
csv file format, 124
Custom, 144

D
Delete, 142
Delete button, 57
Despeckle, 137, 148
Destination Application

text file format, 123
Destination application, 53, 58, 69, 77, 87

Burn to CD, 83
Email application properties, 99
Event Forward (STI), 105
Image application properties, 108
Microsoft Explorer (HTML), 104
OCR, 56, 122
Text application properties, 101
Text file format, 72
Transfer to Storage properties, 84

Detect control sheet, 144
Detect stapled documents, 146
dither, 149, 150
DOC file format, 122
Document Management, 58
documentation, 18
Dots per inch (dpi), 62, 74, 160
Double Feed Detection (DFD), 146
Duplex, 63
Dynamic Threshold, 150
Dynamic threshold, 150

E
Edge Cleanup, 137
Edit button, 57
eMail, 58
Error Code, 174
Error Codes, 175
error diffusion, 149, 150
Event Forward (STI), 59, 105
Xerox DocuMate 4790
User’s Guide

207



Index
Excel Spreadsheet, 124
Export, 141

F
Fax and Print, 59
File format, 53, 69, 74
file format, 124
Fit to page, 86
flowing page, 134
Format tab, 132
Front and Back background color, 155

G
Gamma, 65
Grayscale, 143
Grayscale mode, 62, 65

H
halftone, 149, 150
Hardware properties, 55
HTM file format, 104
htm file format, 124
HTML Document, 124
HTML page, 104
Hue, 65

I
Image Documents Properties, 108
Image Editors, 58
Image file formats, 70
Import, 142
Imprinter, 174
Improvements and Settings, 63
Instant Delivery, 59
Interface, 174
Internet Options, 99
Invert Image, 64, 148
ISIS Interface, 161

J
JPG

Image quality and file size, 71, 72
JPG file format, 69
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Key icon, 61, 63

L
Landscape, 144
Languages in Document, 127
Lock icon, 61, 63
Logical Form Recognition, 40
Long document, 144

M
Maintain aspect ratio, 86
Manual feed mode, 145
Maximize Quality, 71, 72
Memory, 174
Microsoft Internet Explorer, 104
Microsoft Outlook, 58
Microsoft Paint, 58, 108, 157
Microsoft Word, 56, 58, 101, 122
Minimize Size, 71, 72
Mirror Image, 148
Missing Character, 128
Mixed content (automatic separation), 149
Mode, 143
Moiré Patterns, 64
monitor, 17
MRC, 125

N
New button, 57
Normal, 71, 72
Normal PDF, 125
nPDF, 125
Nuance OmniPage® Pro, 40

O
OCR, 123

columns, 133
tables, 133

OCR Dictionary, 128
OCR input format, 133
OCR Options, 126
OCR output format, 133
OCR tab, 127
OmniPage® Pro, 40, 139
One Touch



Index
Button panel, 55
icon, 54, 56
New settings, 56
Options tab, 58
Panel features, 54
properties, 56, 74, 77, 83, 87, 105, 122

One Touch Properties window
options, 61

OneTouch Button Panel
names, 53

Optical Character Recognition (OCR), 58, 72, 122
Options tab, 58

P
Page orientation, 144
Page Settings tab, 63
Page size, 144
Page type, 144
paper jam, 166
Paper size, 63
PaperPort®, 139
Patch codes, 147
PDF

Image quality and file size, 71, 72
PDF applications, 58
PDF Destinations, 110
PDF file format, 58, 69
Photo (dither / halftone / error diffusion), 149
Picture type, 160
Portrait, 144
Properties button, 57

Q
QuickScan, 161

R
Recognition Quality, 128
Redaction tab, 66
Reduce Moiré Patterns, 64
Refresh, 155
Refresh button, 57
Register, 39
Reject Character, 128
Resolution, 62, 74, 143, 160
Rich Text Format, 124
RTF file format, 56, 122
rtf file format, 124
S
Saturation, 65
Save, 141
Scan configuration, 53, 79

Edit or Delete, 61
Lock or unlock, 63
New, 61

Scan Profile, 141
Scan Settings Tab, 62
Scan to Folder, 77

Multiple folders, 79
Scanner

connecting, 27
Parts List, 195
Uninstall, 193

scanner
components, 19
connecting, 27

Scanner Condition, 174
Scanner Counter, 175
Scanner Information, 155, 174
Scanner memory, 155
Scanner Status, 174
Scanning mode, 61, 62, 74, 158
Screen Resolution, 99, 108
Searchable PDF, 124
Select Button, 58
Select configuration, 57

Properties, 62
Select destination, 58
Select format, 56
Send to Application, 113
Serial number, 155
shading adjustment, 175, 178
Show all destinations, 58
Show Progress Window, 59
Simple Text, 124, 125
Size, 63
Skip Blank Originals, 64
Sleep Mode, 175
Software, 32, 40
sPDF, 124
Speckle diameter, 148
spreadsheet, 133, 134
Start Shading, 179
Status light, 190
Sti event forwarding, 59
Still Image Client, 105
Storage and CD-R/W, 58
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Index
Straighten Image, 64
Summary, 142
System, 175
system requirements, 17

T
Text (threshold), 149
Text Documents Properties, 101
Text Editors, 58
text file format, 123
Text file formats, 72
Threshold, 150
Threshold technique, 149
TIFF file format, 69, 70
Total number of pages scanned, 155
Transfer to Storage, 77, 79
true page, 134
TWAIN Driver Information, 155
TWAIN interface, 74, 75, 140
TWAIN standard, 139
TXT file format, 56, 122

U
Uninstall Software, 193
Update All Counter, 175
Updates, 39
USB cable, 34
USB port, 35
Use languages and dictionaries to improve 

accuracy, 127
Use MRC, 125
user dictionary

edit, 130
new, 128

User Guides, 42
User Shading, 175, 179
User Utility, 174

W
Waiting Time, 178
Watermark, 65
WIA

Advanced settings, 160
WIA interface, 74, 157
Windows Image Acquisition, 157
Word Document, 124
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